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1 Document Overview
This document is intended to provide a quick overview of the front and rear panels,
user interface and basic operation of the DNA6000-R series vector network analyzer.
TIP
« For the latest version of this manual, download it from the official website of RIGOL (

)-
Publication Number
UGR03101-1110
Software Version
00.00.11

Software upgrade might change or add product features. Please acquire the latest
version of the manual from RIGOL website or contact RIGOL to upgrade the software.

Format Conventions in this Manual

1. Key

The front panel key is denoted by the menu key icon. For example,
indicates the "System" key.

2. Menu

The menu item is denoted by the format of "Menu Name (Bold) + Character
Shading" in the manual. For example, Frequency indicates clicking Frequency to
enter the frequency setting menu.

3. Operation Procedures

The next step of the operation is denoted by ">" in the manual. For example,
Frequency > Center indicates first clicking Frequency, and then clicking Center.

Content Conventions in this Manual

DNAG6000-R series vector network analyzer includes the following models. Unless
otherwise specified, this manual takes DNA6264-R as an example to illustrate the
functions and operation methods of the DNA6000-R series.

Model Frequency NCuh?r?ﬁglgf Connector
DNA6082-R 5 kHz to 8.5 GHz 2 N-type Female
DNA6084-R 5 kHz to 8.5 GHz 4 N-type Female
DNA6142-R 5 kHz to 14 GHz 2 N-type Female
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Model Frequency Nc“h?.?ﬁéﬁf Connector
DNA6144-R 5 kHz to 14 GHz N-type Female
DNA6202-R 5 kHz to 20 GHz ggm{:ctTgrreaded Male
DNA6204-R 5 kHz to 20 GHz g-gmglctTgrreaded Male
DNA6262-R 5 kHz to 26.5 GHz %-gm]fgcmeaded Male
DNA6264-R 5 kHz to 26.5 GHz %gm}fgcmreaded Male

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



Safety Requirement
EN

2 Safety Requirement

2.1 General Safety Summary

Please review the following safety precautions carefully before putting the instrument
into operation so as to avoid any personal injury or damage to the instrument and
any product connected to it. To prevent potential hazards, please follow the
instructions specified in this manual to use the instrument properly.

. Use Proper Power Cord.

Only the exclusive power cord designed for the instrument and authorized for
use within the local country could be used.

. Ground the Instrument.

The instrument is grounded through the Protective Earth lead of the power cord.
To avoid electric shock, it is essential to connect the earth terminal of the power
cord to the Protective Earth terminal before connecting any inputs or outputs.

¢ Observe All Terminal Ratings.

To avoid fire or shock hazard, observe all ratings and markers on the instrument
and check your manual for more information about ratings before connecting
the instrument.

«  Use Proper Overvoltage Protection.

Ensure that no overvoltage (such as that caused by a bolt of lightning) can reach
the product. Otherwise, the operator might be exposed to the danger of an
electric shock.

. Do Not Operate Without Covers.
Do not operate the instrument with covers or panels removed.
+ Do Not Insert Objects Into the Air Outlet.

Do not insert anything into the holes of the fan to avoid damaging the
instrument.

. Use Proper Fuse.

Please use the specified fuses.
«  Avoid Circuit or Wire Exposure.

Do not touch exposed junctions and components when the unit is powered on.
. Do Not Operate With Suspected Failures.

If you suspect damage occurs to the instrument, have it inspected by RIGOL
authorized personnel before further operations. Any maintenance, adjustment or
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replacement especially to circuits or accessories must be performed by RIGOL
authorized personnel.

+  Provide Adequate Ventilation.

Inadequate ventilation may cause an increase of temperature in the instrument,
which would cause damage to the instrument. So please keep the instrument
well ventilated and inspect the air outlet and the fan regularly.

« Do Not Operate in Wet Conditions.

To avoid short circuit inside the instrument or electric shock, never operate the
instrument in a humid environment.

« Do Not Operate in an Explosive Atmosphere.

To avoid personal injuries or damage to the instrument, never operate the
instrument in an explosive atmosphere.

*  Keep Instrument Surfaces Clean and Dry.

To avoid dust or moisture from affecting the performance of the instrument,
keep the surfaces of the instrument clean and dry.

. Prevent Electrostatic Impact.

Operate the instrument in an electrostatic discharge protective environment to
avoid damage induced by static discharges. Always ground both the internal and
external conductors of cables to release static before making connections.

e Use the Battery Properly.

Do not expose the battery (if available) to high temperature or fire. Keep it out of
the reach of children. Improper change of a battery (lithium battery) may cause
an explosion. Use the RIGOL specified battery only.

. Handle with Caution.

Please handle with care during transportation to avoid damage to keys, knobs,
interfaces, and other parts on the panels.

Equipment meeting Class A requirements may not offer adequate protection to broadcast
services within residential environment.

2.2 Safety Notices and Symbols

Safety Notices in this Manual:

Indicates a potentially hazardous situation or practice which, if not avoided, will result in
serious injury or death.
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2.3

2.4

CAUTION

Indicates a potentially hazardous situation or practice which, if not avoided, could result

in damage to the product or loss of important data.

Safety Notices on the Product:

. DANGER

It calls attention to an operation, if not correctly performed, could result in injury
or hazard immediately.

. WARNING

It calls attention to an operation, if not correctly performed, could result in
potential injury or hazard.

. CAUTION

It calls attention to an operation, if not correctly performed, could result in
damage to the product or other devices connected to the product.

Safety Symbols on the Product:

A A D F L

Hazardous Safety Warning Protective Earth Chassis Ground Test Ground
Voltage Terminal

EMC Level

Class A (for non-residential products)

NOTE:

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
own expense.

Ventilation Requirement

This instrument uses a fan to force cooling. Please make sure that the air inlet and
outlet areas are free from obstructions and have free air. When using the instrument
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2.5

in a bench-top or rack setting, provide at least 10 cm clearance beside, above and
behind the instrument for adequate ventilation.

CAUTION

Inadequate ventilation may cause an increase of temperature in the instrument, which
would cause damage to the instrument. So please keep the instrument well ventilated and
inspect the air outlet and the fan regularly.

Working Environment

Temperature

Operating: 0°C to +40°C

Non-operating: -20°C to +70°C

Humidity

e Operating:
Below +30°C: <95% RH (without condensation)
+30°C to +40°C: <75% RH (without condensation)

. Non-operating:
Below +40°C: 5% to 90%, without condensation
+40°C to +60°C: 5% to 80%, without condensation

+60°C to +70°C: 5% to 40%, without condensation

To avoid short circuit inside the instrument or electric shock, never operate the
instrument in a humid environment.

Altitude

Operating altitude below 2,000 m (6,561.68 feet)
Protection Level Against Electric Shock

ESD +8kV

Installation (Overvoltage) Category

This product is powered by mains conforming to installation (overvoltage) category II.

Ensure that no overvoltage (such as that caused by a bolt of lightning) can reach the
product. Otherwise, the operator might be exposed to the danger of an electric shock.
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Installation (Overvoltage) Category Definitions

Installation (overvoltage) category | refers to signal level which is applicable to
equipment measurement terminals connected to the source circuit. Among these
terminals, precautions are done to limit the transient voltage to a low level.

Installation (overvoltage) category Il refers to the local power distribution level which
is applicable to equipment connected to the AC line (AC power).

Pollution Degree
Pollution Degree 2

Pollution Degree Definition

»  Pollution Degree 1: No pollution or only dry, nonconductive pollution occurs.
The pollution has no effect. For example, a clean room or air-conditioned office
environment.

*  Pollution Degree 2: Normally only nonconductive pollution occurs. Temporary
conductivity caused by condensation is to be expected. For example, indoor
environment.

e Pollution Degree 3: Conductive pollution or dry nonconductive pollution that
becomes conductive due to condensation occurs. For example, sheltered
outdoor environment.

*  Pollution Degree 4: The pollution generates persistent conductivity caused by
conductive dust, rain, or snow. For example, outdoor areas.

Safety Class

Class 1 — Grounded Product

Care and Cleaning

Care

Do not store or leave the instrument where it may be exposed to direct sunlight for
long periods of time.

Cleaning

Clean the instrument regularly according to its operating conditions.

1. Disconnect the instrument from all power sources.

2. Clean the external surfaces of the instrument with a soft cloth dampened with mild
detergent or water. Avoid having any water or other objects into the chassis via the
heat dissipation hole. When cleaning the LCD, take care to avoid scarifying it.

CAUTION

To avoid damage to the instrument, do not expose it to caustic liquids.
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To avoid short-circuit resulting from moisture or personal injuries, ensure that the
instrument is completely dry before connecting it to the power supply.

2.7 Environmental Considerations

The following symbol indicates that this product complies with the WEEE Directive
2012/19/EU.

A

The equipment may contain substances that could be harmful to the environment or
human health. To avoid the release of such substances into the environment and
avoid harm to human health, we recommend you to recycle this product
appropriately to ensure that most materials are reused or recycled properly. Please
contact your local authorities for disposal or recycling information.

You can click on the following link
to download the latest version of the ROHS&WEEE
certification file.
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3 Product Features

Product Features

. Frequency range: 5 kHz to 26.5 GHz

. Models with 2 or 4 ports are available for different test scenarios

. Frequency resolution 1 Hz

. Max. output power 10 dBm

. High dynamic range 127 dB (typ.)

«  Trace noise: 0.003 dB

. IF BW: 1 Hz to 10 MHz

¢ Compatible with the mechanical calibration kit and the Ecal electronic
calibration kit, supporting various calibration types (SOLT, Response Short,
Response Open, OSL, Enhanced Response 1 to 2, Response Through)

. Integrates S-parameters, impedance, VSWR, TDA, fixture embedding/de-
embedding, antenna test, and etc.

. Compact size: 432 mm x 43.9 mm x 440 mm

«  Supports LAN, USB Device, USB Host, HDMI, GPIB, and Application I/O
interfaces

«  Supports standard SCPI instruction sets

e Supports Web Control for remote operation

«  Allowing you to use externally connected keyboard and mouse to input values

DNAG6000-R series vector network analyzer provides various calibration methods
such as frequency response, single-port, response isolation, enhanced response, full
dual-port, and electronic calibration. It supports various display formats such as Log
Mag, Lin Mag, SWR, Phase, Group Delay, Smith Chart, and Polar Chart. Through the
connectivity with the instrument under test via the standard interfaces such as USB,
LAN, and HDMI, this series can accurately measure the amp/freq characteristics,
phase/freq characteristics, and group delay characteristics of the microwave
network.

While maintaining the high-performance characteristics in terms of its
specifications, appearance, display effects, and software interface, the DNA6000-R
series features compact size, light weight, and low noise, offering you better user
experience. This series product can be widely used in the electronics,
communication, and microwave fields. It is the commonly used test instrument in
the R&D and batch production for the industry and universities.
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4

4.1

4.2

Quick Start

General Inspection

1. Inspect the packaging

If the packaging has been damaged, do not dispose the damaged packaging or
cushioning materials until the shipment has been checked for completeness and
has passed both electrical and mechanical tests.

The consigner or carrier shall be liable for the damage to the instrument resulting
from shipment. RIGOL would not be responsible for free maintenance/rework or
replacement of the instrument.

. Inspect the instrument

In case of any mechanical damage, missing parts, or failure in passing the electrical
and mechanical tests, contact your RIGOL sales representative.

. Check the accessories

Please check the accessories according to the packing lists. If the accessories are
damaged or incomplete, please contact your RIGOL sales representative.

Recommended Calibration Interval

RIGOL suggests that the instrument should be calibrated every 18 months.

Product Overview

DNAG6000-R series vector network analyzer offers multiple calibration methods
including frequency response, single port, response isolation, enhanced response, full
two port, and electrical calibration. It supports various data display formats including
log magnitude, linear magnitude, SWR (Standing Wave Ratio), phase, group delay,
Smith chart, polar plot, etc. Equipped with standard USB, LAN, and HDMI interfaces,
the instrument accurately measures the magnitude-frequency, phase-frequency, and
group delay characteristics of microwave networks. This product can be widely
applied in fields such as electronics, communication and microwave. It is a commonly
used testing equipment in the research and production processes of industries and
universities.

10
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4.2.1 Appearance and Dimensions

440

Unit: mm

Figure 4.1 Front View of DNA6000-R

43. 90

Unit: mm

Figure 4.2 Side View of DNA6000-R

4.2.2 Front Panel

Figure 4.3 Front Panel of DNA6000-R Series
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4.2.3

1. Power Key
Powers on or off the instrument. When it is powered on, the power key indicator is
constant on, illuminated in green.

2. USB HOST Interface
The analyzer can serve as a "master” device to connect to the external USB device.

The USB storage device, mouse, and keypad board can be connected to the
instrument via the interface.

3. Type-C Interface

Used to connect the USB storage device.
4. Indicator
When the Acq indicator is constant on, it indicates that the system works normally.
When LAN indicator blinks, it indicates that the network communication is normal.
5. Test Ports
Indicate the input and output connectors of the test signal. The LED indicator at

the left-lower corner of each test port indicates the output status of the signal
source. It is illuminated when a signal is output from this connector.

Rear Panel

11

Figure 4.4 Rear Panel of DNA6000-R Series

1. TRIG IN

SMA connector, used to input external trigger signal to the instrument.
2. TRIG OUT

SMA connector, used to output external trigger signal.
3. 10MHz IN

SMA connector, used to input external reference clock signal.

4. 10MHz OUT

12
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An SMA connector that can output the 10 MHz clock signal generated by the
internal crystal oscillator inside the instrument.

. USB DEVICE

Connects the instrument to the PC via this interface.

. USB HOST Interface

Two USB HOST interfaces, used for powering external devices and data
communication.

.LAN

Connects the instrument to network via this interface. The instrument is in
compliance with the standards specified in LX/ Device Specification 2071. It can be
used to set up a test system with other standard devices. Then you can control the
instrument through using Web Control to send the SCPI commands when the
instrument is connected to the network.

. HDMI

Connects the instrument to an external display that has the HDMI interface (e.g.
monitor or projector) via this interface to better observe the waveform display
clearly.

. Application 1/0

Used to connect the external slave device for control.

The connector transmits the following signals:
- Power: one 5V output and one GND;
- Control signal: PortA/PortB extension port, outputting 10 control signals;

- Information communication: UART (RX/TX) port, transmitting & receiving,

alarming, cascaded control;

- Status indicator: slave feedback ALERT/DONE signal;

Table 4.1 Description of the Connector Pin

Pin No. |1/O0 Type f\ligr':]ael Function Remarks
P POWER |VCC 5V power output
Power pin
P POWER |GND Ground pin

PortA E | Whether to use Enable PortA

(0] TTL . ]
PortA for extension |extension

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.
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Pin No. |1/0 Type ﬁgn‘ael Function Remarks
4 0 L (F;ortA_bit PortA -extension
port bit0
PortA bit | PortA extension
5 0 TTL 1or D! port bit1 PortA extension
control pin
PortA bit | PortA extension 4-bit encoding for
6 0 TTL 2 - port bit2 Port1-16 selection
7 o TL gortA_bit PortA ?xtension
port bit3
Whether to use Enable PortB
8 0O TTL PortB EN . .
- PortB for extension |extension
PortB bit | PortB extension
9 0 TTL 0 - .
port bit0
PortB bit | PortB extension )
10 o TTL jore-b! oort bit1 PortB extension
control pin
PortB bit | PortB extension 4-bit encoding for
11 O TTL 2 - port bit2 Port1-16 selection
12 0 7L gortB_bit PortB <‘axtension
port bit3
Reports
information from
13 | L UART RX |' )
~—  |slave device to
master device UART
communication pin
Sends information
14 @) TTL UART TX |to the slave device
from master device
Sends feedback
ALERT/ |signal to the master | Status indicator pin
15 I TTL DONE .
device from slave Alert/Done
device

10. Power Socket

Used to connect to the 800 W power supply module.

11. GPIB

14
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GPIB connector, used for instrument control and data communication.

4.2.4 User Interface

P: ?

IF Bandwidth Main
100.00 kHz

veraging

= i

Averaging
Restart

Averaging Type

Continuous = BW=100.00 kHz | Co ) Fert LRI e

> 4
No. Description
1 Quick Operation Toolbar
2 Window Display Area
3 Function Menu Area
4 Notification Area
5 System Status Bar
4.2.41 Quick Operation Toolbar

The following figure shows the quick operation toolbar, and the table below it lists
the functions of the quick operation keys on the toolbar.

1 2 3 4 5 6 7 8 9 10 11 12 13 14
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No. Description

1 Adds a new trace.

2 Adds a new channel.

3 Adds a new window.

4 Adds a new sheet.

5 Adds a new trace to a new window.

6 Adds a new trace and channel to a new window.

7 Adds a new trace and channel to a new window in a new sheet.

8 Adds a new trace and a new channel to a new window in a sheet.
Shortcut key for "Delete". By default, it deletes the Active Trace. If there

9 is no Active Trace (i.e.,, an empty window), it deletes the Active Window.
If the Sheet is empty, it deletes the Active Sheet, the last sheet cannot
be deleted.

10 Manual trigger key.

11 Shortcut key for Auto Scale. Adjusts the parameters to the optimal state
of the signal.

12 Saves the screenshot of the current screen.

13 Restores the system to preset settings.

14 Displays the help document.

16
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4.2.4.2 Window Display Area

14 13 12 11 10 9

No. Description

Indicates sheet name. When there is only sheet, no sheet label is
1 displayed. Click on the sheet tab to switch the sheet. You can also
rename the sheet. Each sheet can contain multiple windows.

Indicates window. Traces can be displayed in the window. The
definitions for the horizontal coordinate and vertical coordinate are
related to the measurement parameter and data format. One sheet can
display up to 9 windows. For the newly added windows, you can click

2 Pg Up or Pg Dn to view the desired window.

«  Single-clicking one window can make it become the active window.
. Double-clicking the window area can maximize the currently

selected window; double-clicking it again to restore to the multi-
pane windowing.

. Dragging the scale on the Y-axis can modify the reference level.

Indicates trace. It is a set of measurement data points.

3

Clicking on the specified trace can select it as the active trace.
4 Indicates the trace number. Currently, it is not selected.
5 Indicates the trace number. Currently, it is selected.

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved. 17
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No. Description

6 Indicates the trace title. By default, it displays the test parameters.

7 Indicates the data format of the trace. In this figure, LogM indicates the
log magnitude format.

8 Indicates Scale/Reference Level (related to the measurement data
display format)

9 Indicates the stop frequency of the sweep.

10 Indicates the window number. Currently, the window is selected.

11 Indicates the trace for the channel. Its color is the same as the color of
the trace for the specified channel.

12 Indicates the start frequency of the sweep.

13 Indicates the channel number.

14 Indicates the window number. Currently, the window is not selected.

Function Menu Area

Enter the Function Menu to make the settings.

1
2
New Trace 4 Add Trace 4
New Trace + Channel
4 Delete Trace
New Trace + Window
Trace Hold
New Trace + Channel - . ot 5
+ Window
New Traces...
Stop 14.0000 GHz
6

No. Description
1 Function menu name. You can click the drop-down button to switch
to select other function menus.
2 Secondary sub-menu (unselected)

18
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No. Description

3 Secondary sub-menu (selected)

4 Third-level sub-menu. You can click the drop-down button (<) to
select the sub-menu under it.

5 Forth-level sub-menu

6 Shows/Hides the function menu

4.2.4.4 System Status Bar
Displays the main parameters of the current system status.
Tr1 | Ch1 | Internal Trig | Continuous | BW=100 kHz | No Correction
1 2 3 4 5 6 7
No. Description

1 Active trace

2 Active channel

3 Trigger source. Currently it is set to internal trigger. It can be
configured in the Trigger menu.

4 Trigger mode, currently set to continuous trigger. It can be configured
in the Trigger menu.

5 IF bandwidth, which can be set in the Avg BW menu.

6 Calibration type. After calibration, it displays the calibration type. If
correction is disabled, it displays No Correction.

7 Internal stimulus source. It displays the RF power status for all
channels and can be configured in the Power menu.

4.2.45 Notification Area

Displays LAN icon, sound icon, and remote control icon as well as date and time. You
can click this area to open the "System" menu.

Rmt LXI @x 2025-06-0519:10:43
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No. Description
Remote control icon. When you use Web Control to control the

instrument remotely, & will be displayed.

LAN icon. When the LAN interface is successfully connected, - is

displayed.
Sound icon. Click on this icon to turn on or off the sound. When
1 enabled, RS will be displayed ; when disabled, Sl il be displayed.

USB storage device icon: When a USB storage device is detected, =
will be displayed.

External Clock Icon: When you use the external 10 MHz clock signal
will be displayed.

5 Date: displays the system date. You can set it in the Setting sub-menu
under System.

3 Time: displays the system time. You can set it in the Setting sub-menu
under System.

4.3 To Prepare for Use

4.3.1 To Connect to Power

Please use the power cord provided in the accessories to connect the spectrum
analyzer to the AC power source. The AC power source supported by the instrument
is 100-240 V, 50-60 Hz. The power consumption of the instrument cannot exceed
100W(400VA). When the spectrum analyzer is connected to the AC power source via
the power cord, the instrument automatically adjusts itself to within the proper
voltage range, and you do not need to select the voltage range manually.

ﬂrn N=3 %ﬂ;}éﬂﬂﬁﬂuﬂagsmﬂa@mgﬁﬁﬂnﬂaﬂﬂn SIS o

0000 B oemoliitiitatsntlolils o

Connect to Power

Figure 4.5 Connect to Power

CAUTION

To avoid electric shock, ensure that the instrument is correctly grounded.

4.3.2 Turn-on Checkout

. Power on

20 Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.
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- After connecting the instrument to the power source properly, press the

power key n on the lower-left corner of the front panel to power on the
instrument. During the start-up process, the instrument performs a series of

self-tests. After the self-test, the splash screen is displayed.

- Click the Notification Area and select Setting > Power Switch in the
displayed System menu. By default, the Power Switch menu is enabled.
The instrument will be powered on automatically after the instrument is
connected to power.

. Shutdown

- Press the power key n and a prompt message "Are you sure to shutdown?"
is displayed. Click OK to shut down the instrument.

- Press n twice to directly shut down the instrument.

- Press n for three seconds to directly shut down the instrument.

4.3.3 To Set the System Language

This series supports multiple system languages. To select the desired language, click
the notification area at the lower-right corner of the screen to select Setting >
Language.

4.4 Basic Operation

This chapter introduces the basic operation of the instrument.

4.4.1 To Connect to the Display and the Control Device

DNAG6000-R series does not have an LCD display or monitor. To set the parameters
and view the measurement results, you need to connect it to an external control and
display device. You can use the externally connected monitor, mouse, or keyboard to
control the DNA6000-R series.

Mouse Operation Rule

Connect the mouse to the instrument via the USB HOST interface to perform the
following operations. Note that you can only use the left mouse button to perform
the left-click operation. Right-click and mouse rolling operation are not allowed.

1. Click the mouse to select the menu and window.

2. Long press the left mouse button to drag the displayed data or window.
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4.4.2

3. In the Marker menu, click the mouse to move the marker, but you are unable to

use the mouse to add a marker.

Keypad Board Operation Rule

After the keypad board is properly connected to the instrument via the USB HOST
interface, and then you can use the shortcut keys on the keypad to perform the same
function as what you do with the Function key.

Externally Connected Device Operation Rule

You can configure the parameters for the function menu, measurement results, and
other information on the user interface through the display device (e.g. LCD, TV,
projector, etc.) externally connected via the rear-panel HDMI interface.

Menu Operation

The menu operation includes the following types.

1 Input a Parameter Value

Velocity Factor Click the specified menu, then use the numeric keys to
Doks modify the value directly.

2 Select a Parameter

Distance Unit Click the specified menu, its sub-menus are displayed.
4 Meters Bl Select the desired parameter from the drop-down list.

3 Switch between the Option Tab

Click the desired tab to switch between the alternative tab.

4  Select a Sub-menu

Click the specified menu with the cascading sub-menus to
4 Port Extensions .
select the specified sub-menu.

7 Direct Execution

Ali off Click the specified menu to execute the corresponding
function.

6 Check to Enable the Function (without parameter)
Check the checkbox of the specified menu to enable the
Channel 1 function. If the checkbox turns green, with a tick in it, this

function is enabled.

5 Check to Enable the Function (with parameter)

Check the checkbox of the specified menu to enable the
function. Then click the parameter input field to input the
value or characters to modify the parameter.

22
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4.4.3

4.4.4

Check the checkbox of the specified menu to enable the
function. If the checkbox turns green, with a tick in it, this
function is enabled.
8 Menu Selected
Click the specified menu, and the selected menu is
highlighted in a green box. You can click the desired
marker, trace, channel, window, or sheet to make them be
selected.

TIP

The above menu operations can also be realized through externally connected mouse, touch

screen operation, or Web Control operation.

To Use the Built-in Help System

The built-in help document of the vector network analyzer provides information
about the functions and menu introductions of the instrument.

Click on the help icon on the quick operation toolbar at the top of the main interface,
then the Help documentation is displayed. You can get its help information by
clicking on the link for the introduction of the specified function.

To View the Option and the Option Installation

This series vector network analyzer provides many options to meet various
measurement requirements. If you need any of these options, order them according
to the Order No. available in Data Sheet, and then install the options according to this
section. Besides, you can also view the options currently installed on the vector
network analyzer and activate the newly purchased option.

1. View the Installed Option

If your instrument has currently installed the option, perform the following
operations to view the name of the installed option and other detailed information
about the option from the option list.

Click the notification area in the lower-right corner of the screen to pop up the
system menu. Click Options to view the options currently installed.

2. Install the Option

The option license is a string with a fixed number of characters. Each instrument
has one unique license. The license file should be in specific format, with the
filename extension "*.lic". After you purchase an option, you will obtain a key (used
for obtaining the license). Then, you can install the option according to the
following steps.

a. Obtain an option license

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.
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4.5

Log in to the RIGOL official website ( ), click SERVICE
CENTER > LICENSE ACTIVATION to enter the license activation interface.

Input the correct key, serial number (click About to acquire the serial number of
the instrument), and verification code. Click Generate to acquire the download
link for the option license file.

b. Install the option

Install the option by sending SCPI commands. For details, refer to Programming
Guide of the product. After installation, a prompt message "Option activated
successfully” is displayed. After the option has been installed, you are
recommended to restart the instrument.

TIP
. During the installation process, you are not allowed to power off the instrument.

. Installing options by sending SCPI commands is supported. Installing options by
inputting the license code manually is not supported.

Basic Test Procedures

The following procedures guide you how to make the measurement settings for the
analyzer.

1. Set the Measurement
Sets the analyzer, creates the measurement, and adjusts the measurement display.

a. Use the preset settings or user-defined settings of the analyzer: you can preset

the analyzer ( ) or recall ( ) the user-defined settings.
b. Create a channel ( ) and a trace ( ).
c. Select a measurement parameter ( ).
d. Set the sweep type and points ( ).
e. Set the frequency span ( ).
f. Set the port power ( )-
g. Set the trigger ( )-
h. Set the data format ( ).

i. Set the scale ( ).
j- Set the user-defined window display ( and )-

2. Optimize the Measurement

24
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A measurement has many interdependent settings. You can modify the settings to
achieve faster processing or greater measurement accuracy.

Achieve Faster Processing
- Fast sweep ( )

Use the sweep frequency span required for the measurement device
Use the minimum number of points required for the measurement
Segment sweep: use segments to focus test data only where you need it.

Auto sweep time: use this default to sweep as quickly as possible for the current
settings.

- Disable the unnecessary functions, including ) , A

, etc.

- Use SCPI commands to remotely control ( ) the VNA via LAN

interface to performance auto measurement.

Improve Measurement Accuracy

Increase dynamic range

- Reduce noise, including . ,and

- Group Delay ( )

- Set the electrical delay ( ), phase offset ( ), and port
extension ( ) to improve the phase measurement accuracy.

. Perform the Measurement Calibration

Performs the calibration to reduce the measurement errors.
- Basic calibration: Selects the calibration type (

) and calibration kits ( ). You can select the
available calibration kits from the standard calibration kits, and can also load
the user-defined calibration kit ( ). You can also
load the user-defined calibration sets file to recall the calibration data. Note

that the calibration sets file you recalled shall match the current sweep settings.
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Electronic calibration: You can select the desired electronic calibration kit

( ) based on the selected calibration type and port to
perform the calibration.

Advanced calibration function: Port extension ( ), port match (

), port Z ( ), and 2-port DeEmbed ( ).

4. Analyze Data

Analyzes the measurement results with marker, math operations, and limit tests.

function provides the readout of measured data, searches for specific
values ( ), and modifies the stimulus settings. Each trace has 15 normal
markers and one reference marker (used with Delta marker).
Use the data math operation ( ) to perform four types of math
operations on the active trace and memory trace.
The limit line measurement function ( ) allows you to compare the

measurement data with the user-defined conditions.

5. Save and Recall Data

Saves ( ) and recalls ( ) measurement data files to and from an internal or
external storage device in various formats. The file formats include:

Instrument state and calibration data (*.csa, *.sta, and *.cal)

Measured data file (*.snp and *csv)

26
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Traces are a series of measured data points. The data points in one measurement
share the same trace number and are saved as one trace.

. Each sheet supports up to 100 traces. Up to 500 windows are supported.
e One channel supports 16 traces.

The trace state information is displayed at the top of each window. The trace number
highlighted indicates the current active trace. For details, refer to

The trace setup will affect the presentation and math operations of the measurement
data. The following lists the trace related items for trace setup.

. Measurement Parameter, Parameter Conversion
. Format and Scale

«  Averaging, Smoothing

«  Correction ON/OFF

. Electrical Delay

. Phase Offset, Amplitude Offset

«  Trace Math

. Markers

- TDA, DTF

5.1 Trace 1-8/Trace 9-16

Creates and selects the desired trace quickly. Click the checkbox of the specified trace
to select it. Uncheck the checkbox of the specified trace to remove the trace.

Create the Trace

Click the checkbox of the specified trace from the Trace 1-8 and Trace 9-16 menus to
create the trace quickly. When the trace is available on the screen, the checkbox
ahead of the specified trace is highlighted in green. When the specified trace is
selected, the trace name is highlighted in green box.

After the trace is created, the trace is available in the current active window and the
current active channel. S11 parameter is measured by default.
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Add a Trace

Click New Traces..., then the trace adding interface is displayed, as shown in the
figure below.

Add Trace

S-Parameter Balanced

0 s11 0 s12

'Channel 1 v"iWindow1 v|

Select the window, channel, and the measurement parameter for the trace. If there is
no available channel or window to choose, you can add a new channel or window
first, then create the trace for the channel and the window.

Trace Setup

In the Trace Setup menu, you can select the specified trace, add or delete the trace,
modify the trace title, and set the trace hold.

Select a Trace

Select a trace as the current active trace. Click the drop-down button of "Select" to
select the desired trace. Select the desired trace in the "Trace 1-8" or "Trace 9-16"
menu. You can also click the target trace label at the upper-left corner of the current
window to select the desired trace. To modify the trace title, first select the trace to
make it active, then modify the title.

Modify the Trace Title

Select the specified trace and then modify the trace title. You can also select to
display or hide the trace title.

By default, the checkbox of Title is unchecked. The default trace title represents

the measured S-parameter.

«  To modify the trace title, check the checkbox of the Title menu, and then click
the input field of the title to input the trace title name.

Add a Trace

To add a trace, perform the following operations.

. New Trace: adds a trace in the current active window. The trace is added on the

active channel in the current active window. The trace property is default.

28
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New Trace + Channel: creates a new channel in the current active window, and
creates a new trace for channel. The trace property is default.

New Trace + Window: creates a new window, and creates a new trace in the
new window. The newly created trace belongs to the active channel.

New Trace + Channel + Window: creates a new window, and creates a new
channel in the current active window. Create a new trace for the channel. The
trace property is default.

New Traces...: click New Traces..., then the trace adding interface is displayed.

For detailed configurations, refer to

Delete a Trace

Click Delete Trace, then the drop-down list of all the available traces is displayed.
Click the specified trace to delete the trace.

Trace Hold

When Max or Min is selected for Trace Hold, hold the maximum and minimum
response values at the stimulus values, helping users make extrema analysis.

Off: By default, the trace hold function is disabled.

Max: the trace keeps updating, and if the new response value is greater than the
current max. hold value, then the new max. value prevails. The displayed trace
always represents the max. response value at each frequency point since the
max. trace hold is enabled.

Min: the trace keeps updating, and if the new response value is smaller than the
current hold value, then the new min. value prevails. The displayed trace always
represents the minimum response value at each frequency point since the min
trace hold is enabled.

Restart: resets the trace data and restarts to launch the measurement based on

the currently selected trace hold type.
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6 Channel

In the Channel menu, you can configure the settings for the channel, window, and
sheet.

The features of channels in the VNA device:

1. Signal transmission: Each channel is responsible for sending RF signal from the test
port to the DUT and receiving the reflection signal for measurement and analysis.

2. Independent: Each channel is independent of each other and can be configured
and controlled independently. Therefore, the instrument can make multiple
measurements at the same time or calibrate on different ports.

3. Flexible to measure: Multiple channels are supported, enabling you to measure the
S-parameters of different ports and make a comprehensive analysis for the multi-
port network.

4. Calibration and correction: Each channel can be calibrated and corrected
independently, ensuring the accuracy and reliability of the test results.

5. Data processing: Each channel receives and processes the signal sent from the DUT

for data acquisition, analysis, and display.

6.1 Channel 1-9

Channel determines how to measure and process signals in the VNA device. Each
channel generally consists of a transmit port and a receiver port, which are used to
transmit and receive RF signal, then make signal analysis and measurement. Each
channel has a unique number, and up to 500 independent channels are supported.

The channel settings determine how the trace data is measured. All the traces that are
assigned to a channel share the same channel settings. To modify the channel setting,
first select the channel.

Click Channel 1-9 to enter its sub-menu. 9 channel menus are displayed. If the
checkbox at the left part of the specified channel name is checked and highlighted in
green, it indicates that the channel is available. If the channel name is highlighted in
green box, it indicates that the channel is selected. By default, Channel 1 is selected.
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6.2

. If a channel does not exist, check the checkbox of the specified channel name to
create the channel quickly. If a channel already exists on the screen, uncheck the
checkbox of the specified channel name to delete the channel quickly.

. After deleting the channel, all the traces on the channel will all be deleted.

. Each time you create a channel, a trace (S11 logM trace by default) is
automatically created. A channel without trace does not exist.

« A window can contain no channels or traces. Even if you delete all the channels
and traces from the window, the window without any channels and traces can

still exist.

Channel Setup

Select a Channel

Click the drop-down button of Select, then all the available channels are displayed to
choose. Choose the desired channel to be the selected channel. If you select one
trace, then the channel where the trace is located is also selected.

If you need to modify the parameters of the specified channel, first select the channel.
Add a Channel

Click the drop-down button of Add Channel to add the desired channel.

. New Trace + Channel: creates a new channel, and creates a new trace for the

new channel in the current active window.

. New Trace + Channel + Window: creates a new window and a new channel;

creates a new trace for the new channel in the new window.

The newly created window, channel, and trace are automatically selected.

New IDs with the minimal number that is not in use will be assigned to the newly
created window, channel, and trace

Delete a Channel

Click Delete Channel, then all the existing channels are displayed in the pop-up sub-
menu, select the desired channel to delete it.

Once the channel is deleted, all the traces contained in the channel will all be deleted.

If the currently selected channel is deleted, the channel with the smaller ID number
will become the newly selected channel.
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6.3

Window 1-9

Windows are used to view traces. Each sheet can contain up to 100 traces. The total
number of trace in all the windows in the current sheet cannot exceed 100. The
instrument supports creating 500 windows, and each window has a unique ID, which
is indicated at the lower-left corner of the window. At most, 9 windows can be
displayed on the screen at the same time. If new windows are added, click Pg Dn to
view more windows.

Window Management

Click Window 1-9 to enter its sub-menu. 9 window menus are displayed. If the
checkbox at the left part of the specified window name is checked and highlighted in
green, it indicates that the window is available. If the window name is highlighted in
green box, it indicates that the window is selected.

« If you want to create a window on the screen, check the checkbox of the
specified window name to create the window quickly.

. If you want to delete a window that already exists on the screen, uncheck the
checkbox of the specified window name to delete the window quickly.

. After deleting the window, all the traces in this window will all be deleted. If all

traces in this channel are deleted, then this channel will also be deleted.

Trace Information in the Window

One of the important functions of the window is to display trace curves. A window
can contain up to 100 traces. The trace information of the window is displayed at the
top of the window. For details, refer to

The trace with different data formats can all be displayed in one window. The
definitions for the horizontal coordinate (X-axis) and vertical coordinate (Y-axis) in
different trace formats are different. The scale type shown in the vertical coordinate
indicates the Y-axis type of the currently activated trace.

Channel Information in the Window

The channel information of all the traces in the window is displayed at the bottom of
the window.

Channel4: Start 100.00kHz Stop 26.500GHz

>Channel7: Start 100.00kHz Stop 26.500GHz
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. ">" following a channel No. indicates the currently selected active channel. Only
one channel can be activated globally.

«  The definitions for the Start and Stop values are determined by the sweep type
of the channel. For power sweep, they indicate power values; for frequency
sweep, they indicate frequency values.

*  When multiple channels are available, they are displayed from top to bottom in
sequence.

. The line(s) with different color(s) following the Start value indicates all the traces
of this channel. The line color is the same as the color of the trace displayed in
the window. If multiple traces are available for the channel, they will be displayed

from left to right in sequence.

Window Setup

Select a Window

Click the drop-down button of Select, then all the available windows are displayed to
choose. Choose the desired window to be the new active window. The selected
window is highlighted in green box.

Window Title

Click the input field of "Title", then the virtual keypad is displayed. Input the title of
the current active window with the virtual keypad.

Add a Window

Click the drop-down button of Add Window to add the desired window.

. New Window: creates a new window.

. New Trace + Window: creates a new window and creates a new trace for the
currently activated channel in the window.

. New Trace + Channel + Window: creates a new window, creates a new channel,
and creates a new trace for the new channel in the window.

The newly created window, channel, and trace are automatically activated. New IDs
with the minimal number that is not in use will be assigned to the newly created
window, channel, and trace.
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Delete a Window

Click the drop-down button of Delete Window. All the available windows are
displayed to choose. Select the desired window to delete it. Note that the window
with the green dot located at the left indicates that it is currently selected and
activated.

Once the window is deleted, all the traces contained in the window will all be deleted.
If all traces in this channel are deleted, then this channel will also be deleted.

If you delete the currently activated window, then the window with the minimal ID not
in use among all of the current windows will automatically become the new active
window.

Sheet Setup

Sheets are used to group multiple windows. Multiple sheet tabs can be displayed on
the screen. By default, there is only one sheet when you power on the instrument.
When multiple sheets are available, there will be multiple sheet tabs. Click the
specified sheet tab to switch to the desired sheet. Each sheet can contain multiple
windows. For details, refer to

Select a Sheet

To select an active sheet, perform either of the following operations, perform either of
the following operations.

e Click the drop-down button of Select, then all the available sheets are available
to choose. Select the desired sheet to make it active.

. Click on the sheet tab to switch the sheet. The selected sheet is the active sheet.

Sheet Title

Click the input field of "Title", then the virtual keypad is displayed. Input the title of
the current active sheet with the virtual keypad. The sheet tab name will also be
updated once you have modified the sheet title.

Add a Sheet

Click the drop-down button of Add Sheet to add the desired sheet.

. New Sheet: creates a new sheet.

. New Trace + Sheet: creates a new sheet and creates a new window in the sheet.
Create a new trace for the currently activated channel and display it in the

window.
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. New Trace + Channel + Sheet: creates a new sheet and creates a new window
in the sheet. Create a new channel. Create a new trace for the new channel and

display it in the window.

The newly created sheet, window, channel, and trace are automatically activated. New
IDs with the minimal number that is not in use will be assigned to the newly created
sheet, window, channel, and trace.

Delete a Sheet

Click the drop-down button of Delete Sheet. All the available sheets are displayed to
choose. Select the desired sheet to delete it. Note that the sheet with the green dot
located at the left indicates that it is currently selected and activated.

Once the sheet is deleted, all the windows in the sheet and all the traces contained in
the window will all be deleted. If all traces in this channel are deleted, then this
channel will also be deleted.

If you delete the currently activated sheet, then the sheet with the minimal ID not in
use will automatically become the active sheet. If there is only one sheet left, this last
sheet cannot be deleted.
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7 Frequency

Sets the frequency parameters of the stimulus source.
Frequency Range

Specifies the frequency range for the measurement. Only when you set the sweep
type to "Linear Frequency" or "Log Frequency", can you set the frequency range. After
configuring the frequency range, the start frequency and stop frequency values are
displayed at the bottom of the window.

Click Frequency > Main to set the start frequency, stop frequency, center frequency,
and span. They have a coupling relationship. Once you modify one of them, the rest
three parameters will also be modified accordingly. The frequency step (Step) is
calculated based on the Span value.

* Teenter = (tart + fétop) /2
¢ fépan = (fétop - Ktart)

. fstep = fspan / (number of sweep points - 1)

CW Frequency

CW (Continuous Wave) refers to an electromagnetic wave characterized by constant
frequency and constant amplitude. Only when the sweep type is "Power", can this
menu be enabled.

The range of the CW frequency is from 5 kHz to 26.5 GHz. By default, it is 1 GHz.
Once the CW value is set, it will be displayed at the bottom of the window.
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8 Sweep

A sweep is a series of consecutive data point measurements taken over a specified
sequence of stimulus values. The sweep settings are valid for the current channel. All
the measurement traces for each channel share the same sweep parameters.

8.1 Main

VNA supports multiple types of sweep. The relevant information is displayed below
the window, as shown in the figure below.

511 LogM 10.00dB/ 0.00 d8

: >Ch1: Start 5.00000 kHz ——
Ch Start -10 dBm —— CW 1.00000 GHz

® ®

Linear Frequency

X-axis represents the linear frequency, displayed with equal horizontal divisions in the
X-axis. You need to set the start frequency, stop frequency, and sweep points for the
linear frequency sweep.

«  Start Frequency: sets the start value of the frequency sweep or the start point of
the X-axis. It is displayed at the bottom of the window, following "Start", as @
indicated in the above figure. This menu functions the same as the start
frequency in Frequency menu (click Frequency > Main > Start). Configuration
of this parameter in both Sweep and Frequency menus has the same effect.

. Stop Frequency: sets the stop value of the frequency sweep or the stop point of
the X-axis. It is displayed at the bottom of the window, following with the "Stop”
icon, as @ indicated in the above figure. This menu functions the same as the
stop frequency in Frequency menu (click Frequency > Main > Stop).
Configuration of this parameter in both Sweep and Frequency menus has the

same effect.
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Log Frequency

The X-axis is the frequency stepped in logarithmic increments and the data is
displayed on a logarithmic X-axis. This mode allows you to observe wide frequency
range. The grid is not equally spaced and varies periodically. This is usually slower
than a continuous sweep with the same number of points. It is slower than linear
frequency sweep.

The Log frequency sweep also needs to set the start frequency, stop frequency, and
sweep points. The setting method is the same as that in "Linear Frequency" sweep.

Power Sweep

Activates the power sweep at a single frequency that you specify. The power sweep
either increases or decreases source power in discrete steps. X-axis represents the
linear power.

«  You need to set the start power, stop power, and sweep points for the power
sweep. Wherein, start power indicates the start value of the power sweep or the
start point of the X-axis. It is displayed at the bottom of the window, following
"Start", as @ indicated in the above figure. Stop power indicates the stop value
of the power sweep or the end point of the X-axis. It is displayed at the bottom
of the window, following "Stop", as @ indicated in the above figure.

«  To set the fixed frequency value of the sweep signal, click Frequency > Main >
CW, then input the desired value into the input field of CW. The CW value is
displayed at the bottom of the window, as ® indicated in the above figure.

. Power sweep is optimized for speed. For highest measurement accuracy during a
power sweep, it may be necessary to increase the Dwell Time to allow the source
more time to settle. To set the dwell time, click Sweep > Sweep Timing > Dwell
Time.

«  The Start and Stop sub-menus in the Sweep menu have the same function as
that in Power menu (click Power > Main > Start and Stop). Configuration of the

two parameters in both Sweep and Power menus has the same effect.

Segment Sweep

Segment sweep refers to user-defined one or multiple frequency ranges of sweep
(called segment). For each segment, you can define independent power level, IF
bandwidth, IF bandwidth per port, sweep time, delay time, and dwell time. All the
segments are swept in order, just as other sweep operation.

38

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



Sweep
EN

X-axis represents the linear incremented frequency value, and its display format is the
same as described in the "linear frequency sweep". For detailed setting methods for
the segment sweep, refer to the descriptions in

Sweep Points

Sweep points refer to the number of data points acquired in single sweep. The range
of the sweep points is from 1 to 100,001. By default, it is 201.

*  When the sweep type is "Segment”, sweep points cannot be set.

*  When you modify the sweep points, the instrument starts to re-sweep all the
channels according to the channel No. sequence.

«  To achieve the greatest trace resolution, use the maximum number of data
points. However, the sweep time changes proportionally with the number of
points. To obtain higher throughput, keep the number of points to a smaller
value within an allowable trace resolution.

«  To ensure an accurate measurement calibration, ensure that the number of

sweep points used in calibration is consistent with that used in measurement.

8.2 Sweep Timing

The following figure lists the relationship between the sweep time, delay time, and
dwell time. Point Delay in the figure refers to the dwell time.

n:Number of sweep points
~:Point Delay

Sweep Delay :Measurement time
I [ | | [
1 2 | 3— n
Dwell Time
g Sweep Time |
- Single Sweep (for each stimulus port) -
Sweep Start Sweep Stop
Sweep Time

Sweep time specifies the time the VNA instrument takes to acquire RF data for a
sweep.

The sweep time includes the dwell time but does not include the sweep delay time.
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8.3

Auto Sweep Time

«  Auto (Default): auto adjusts the sweep time, and the dwell time is fixed to be 0
s. If you set the dwell time to a value other than 0, then manual sweep time

configuration is automatically enabled.

¢ Manual: sets the sweep time and dwell time manually. When you configure the

dwell time to 0, then auto sweep time configuration is automatically enabled.

Dwell Time

Specifies the time the VNA instrument stays at each measurement point to complete
the signal stimulus, response acquisition, and data processing. The max. dwell time is
20 s.

Increasing the dwell time will slow the sweep speed, but it increases the measurement
accuracy for the electrically long device.

Delay Time

Specifies the time to wait just before acquisition begins for each sweep. By default, it
is 0 s. Its range is from 0 s to 20 s. This delay is in addition to Dwell Time (per point)
and External Trigger delay if enabled.

Sweep Sequence

e STD: by default, it is standard sweep. The analyzer sweeps all data points for
each source port in sequence. For example, first sweep the S11/S21 parameters
of all the data points, then sweep the S12/522 parameters of all the data points.

+  Point: the analyzer measures all S-parameters at each frequency point before
stepping to the next frequency. The display trace is updated as each data point is
measured. Point sweep usually slow the sweep and is useful only in rare

circumstances.

Segment Control

If you set the sweep type to Segment, you need to configure settings for each
segment. Each channel supports up to 32 segments. This instrument supports up to
4,096 segments.

Add a Segment

Adds a sweep segment at last segment. A new line of segment parameters will be
added in the segment table.

40
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e The start frequency of the newly added segment is the stop frequency value of
the last segment.

+  The added segment will not change the current active segment.

Insert a Segment

Inserts a sweep segment before the selected segment. A new line of segment
parameters will be inserted before the selected segment in the segment table.

«  For the inserted segment, by default, its start frequency is the stop frequency of
its previous segment; its stop frequency is the start frequency of its next
segment.

«  After the new segment is inserted, the new inserted segment is, by default,

selected as the current active segment.

Delete a Segment

Deletes a specified segment from the segment table. If there is only one segment,
after the segment is deleted, the sweep type automatically changes to linear
frequency sweep.

Delete All Segments

Deletes all of the segments from the segment table. After all segments are deleted
from the segment table, the sweep type automatically changes to linear frequency
sweep.

Configure the Segment Table

The segment table and the segment table configuration information are displayed in
the following figure.

Segment Table - Channel 1

B Power i Delay
& Few () IFBW Per Port
B Time [ Dwell
>Ch1: Start 10.0000 MHz Stop 26.5000 GHz

State Start Puints Power Time

ON w 10 MHz A | -5 dBm Os 0s 974.82 ps

By default, the segment table includes the following parameters: segment No., on/off
status of the segment, start frequency, stop frequency, and sweep points. Check the
checkbox of the specified parameters that you want to display in the segment table,
and then the relevant parameters will be displayed in the segment table. Note that
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"IFBW" and "IFBW Per Port" are mutually exclusive, and they cannot be selected at the
same time.

Click the specified parameter value in the segment, then the numeric keypad is
displayed, input the desire value to complete parameter configuration. For the state
setting, click the drop-down button of State to enable or disable the state of the
specified segment. Restrictions for segment sweep configuration:

«  The frequency range of a segment is not allowed to overlap the frequency range
of any other segment. The start frequency of each segment must be greater than
the stop frequency of its previous segment.

«  When the start frequency of a specified segment is smaller than the stop
frequency of its previous segment, a prompt message is displayed, prompting
you to set IF bandwidth to 500 Hz, and automatically set the stop frequency of
the previous segment to the start frequency of the current segment.

e Atleast one segment must be enabled, otherwise, the sweep type automatically
switches to the linear frequency sweep.

. Up to 32 segments are supported.

e The combined number of data points for all segments in a sweep cannot exceed
the max number of data points per trace.

. Each segment is ordered based on the frequency value from high to low.

Display the Segment

Controls whether to display the segment table below the window.

. Auto: (Default)

- Only when you click Sweep > Segment Table to enter the sub-menu of

Segment Table, can the segment table be displayed below the current
active window automatically.

- When you select other sub-menus other than Segment Table under
Sweep, the segment table will not display below the current active window.

+  On: When the current active channel is segment sweep type, the segment table

of the current active channel is displayed below the current active window.

«  Off: segment table is not displayed below the current active window.

42
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9 Measure

The Measure menu enables you to set the measurement parameters for the trace.
9.1 S-Parameter

S-parameters are used to describe the situation of transmission and reflection signals
when a signal meets a discontinuity in impedance. S-parameters are relative
parameters, defined as the ratio of two complex voltages, containing amplitude and
phase information of the related signals.

. Response port, also known as the receiver port of the vector network analyzer.
The transmitted signal goes to this port via the DUT.

e Stimulus port, also known as transmit port of the vector network analyzer. The
output signal on this port goes to the DUT.

For the 2-port vector network analyzer, there are 4 S-parameters: S11, S21, S12, and
S22. The definition for each S-parameter is shown in the following figure.

Port 1 Port 2
| |
|
ar o—4— —:o b2
|
| |
! |
b1 : I az
|
|
|
|
! !
Zo Zo

When the source goes to Port 1, the measurement is said to be in the forward
direction. When the source goes to Port 2, the measurement is said to be in the
reverse direction. The analyzer switches the source and receiver automatically to make
a forward or reverse measurement. Therefore, the analyzer can measure all of the four
S-parameters for a 2-port device with a single connection.

S11 - forward reflection

S21 - forward transmission

. S12 - reverse transmission
. S22 - reverse reflection

The formula is shown as follows:
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by b,
a_z | a;=0 §22 =— a;=0

by b,
A =22 S12 =
s11 o | 4,0 521 - | 4,0 o

Click the specified S-parameter to set the specified measurement parameters for the
currently activated trace.

Table 9.2 Common Measurement with S-Parameters

Measurement Type Measurement Parameter

Return Loss

SWR

Reflection Measurement Reflection Coefficient
Input Impedance

S11, S22

Insertion Loss

Transmission Coefficient
Gain/Loss

Transmission Measurement | Group Delay

Deviation from Linear Phase
Electrical Delay

S21, S12

9.2 Balanced S-Parameter (4-Port)

Balanced S-parameters are designed to precisely characterize the signal behavior
between the differential (balanced) system and the single-ended system. They can
not only describe the transmission and reflection characteristics of signals between
different ports, but also reveals the conversion between differential mode and
common mode.

The instrument supports a combination of three basic signal modes: Single-ended (s),
differential (d), and common mode (c). By properly configuring the port topology of
the DUT and its mapping to the physical ports of the instrument, you can obtain S-
Parameters, the imbalance of the balanced ports, and key metrics such as the
common mode rejection ratio (CMRR) in all modes directly.

TIP

« This feature is only supported by the 4-port model of the Vector Network Analyzer (VNA).
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Port Type

Single-ended Port (SE):

Consists of 1 signal wire to the 1 ground wire, and transmits signals with ground
wire as the reference basis. It is the most basic type of topology, with the
reference impedance of 50 Q. Its advantage lies in its simple structure, and its
disadvantage is the weak anti-interference capability, suitable for low-speed,
short-range signal transmission.

Balanced Port (BAL):

Consists of 2 signal lines (positive/negative) with equal amplitude and reversed
phase, without relying on ground wire, to offset external interference through
differential signal transmission. Its reference impedance is typically 100 Q
(differential mode) or 25 Q (common mode), applicable to high-speed, long-
range transmission.

Signal Mode

Differential Mode: An effective signal mode, defined as the signal difference (A-
B) of two signal lines. It is a core useful signal of balanced transmission with
inherent anti-interference feature.

Common Mode: An interference signal mode, defined as the average value ((A
+B)/2) of the signal of the two signal lines. It is mainly generated by external
electromagnetic interference, asymmetric device structure and other factors.
Ideally, it should be strongly suppressed by the device.

Mixed Mode: In practical applications, the signal of a balanced port is a mixture
of differential mode and common mode. The Balanced S-parameters can

quantify the ratio of the two mode and their mutual conversion.

Configuration

Click Measure > Balanced > Topology to enter the Balanced Setup interface.
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9.2.1

Balanced Setup - Channel 1

Topology

Topology BAL-BAL v |

Balanced Port VNA (+) Port VNA (-) Port
1 BAL Port 1 v | Port2

2 BAL Port 3 v Port4

1. Select the topology type.

2. Configure the ports based on the actual DUT connection.

3. Click Save to save the configuration. In the Balanced sub-menu, you can see the
commonly used balanced S-parameters. To view more balanced S-parameters,
refer to the items under the Other menu.

4. After the current trace is selected, you can select the desired balanced S-parameter

for the trace.

Balanced S-Parameters

The balanced S-parameters are expressed in Sabxy. Where,

«  a: Device output mode (d = differential, c = common mode, s = single-ended)
*  b: Device input mode (d = differential, c = common mode, s = single-ended)
«  x: Device output logical port number

« y: Device input logical port number

For example,

Ssc21 indicates the transmission from "Input Logical Port 1 (Common Mode Balanced
Port) to Output Logical Port 2 (Single-Ended Port)".

Sdd21 indicates the differential transmission from "Input Logical Port 1 (Differential
Balanced Port) to "Output Logical Port 2 (Differential Balanced Port)".

Calculation Formula for Balanced S-Parameters

The Balanced S-parameters are calculated based on a linear combination of the
single-ended S-parameters. The formula is as follows:

46
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Parameter Definition Formula
sdd11 Port 1 Differential Mode 5dd11 = 0.5 x (S11 - 512 - 521
Reflection +S22)
sdd22 Port 2 Differential Mode 5dd22 = 0.5 x (S33 - S34 - 543
Reflection + S44)
Sdd33 Port 3 Differential Mode Sdd33 = 0.5x (533 - 534 - 543
Reflection + S44)
Scell Port 1 Common Mode Scc11 =05 x (511 + S12 + S21
ce Reflection + S22)
cc Reflection + S44)
Sce33 Port 3 Common Mode Scc33 =0.5x (533 + S34 + S43
ce Reflection + S44)
Sdc11 Port 1 (Differential = Common) |Sdc11=0.5x(S11 + 512 - 521 -
Mode Conversion Reflection S22)
Sdc22 Port 2 (Common — Differential) |Sdc22 = 0.5x (S33 + 534 - 543 -
Mode Conversion Reflection S44)
Sdc33 Port 3 (Differential  Common) |Sdc33 =0.5x (533 + 534 - 543 -
Mode Conversion Reflection S44)
Scd11 Port 1 (Common — Differential) |Scd11 =0.5x (511~ 512 + 521 -
Mode Conversion Reflection S22)
Scd22 Port 2 (Common — Differential) |5c¢d22 = 0.5 x (533~ 534 + 543 -
Mode Conversion Reflection S44)
Scd33 Port 3 (Common — Differential) Scd33 = 0.5 x (S33- 534 + 543 -
Mode Conversion Reflection S44)
Port 1 (Single-ended — Single- _
55511 ended) Reflection J 5ss11 = 511
Port 2 (Single-ended — Single- _
55522 ended) Reflection J 55522 = 533
Port 3 (Single-ended — Single- _
Sss33 ended) Reflection 9 Sss33 = S44
sdd12 Port 2 (Differential) — Port 1 Sdd12 = 0.5x (513 - 514 - 523
(Differential) Transmission + S24)
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Sdd21 Port 1 (Differential) — Port 2 5dd21 = 0.5 x (S31 - 532 - 541
(Differential) Transmission + S42)
(Common) Transmission S24)
Sced Port 1 (Common) — Port 2 Sdc21 = 0.5 x(S31 + S32 - S41 -
(Common) Transmission S42)
Sdc12 Port 2 (Differential) = Port 1 Scd12 = 0.5 x (S13- 514 + 523 -
(Common) Transmission S24)
Sdc21 Port 1 (Differential) = Port 2 Scd21 = 0.5 x (S31- 532 + 541 -
(Common) Transmission S42)
Scd12 Port 2 (Common) — Port 1 Scc12 = 0.5x (513 + S14 + S23
(Differential) Transmission + S24)
Scd21 Port 1 (Common) — Port 2 Scc21 = 0.5 x (531 + S32 + S41
(Differential) Transmission + S42)
Port 2 (Differential) — Port 1 _ _
Sds12 (Single-ended) Transmission Sds12 = (813 - 823)/V2
Port 3 (Differential) — Port 1 _ _
Sds13 (Single-ended) Transmission Sds13 = (S14 - S24)/V2
Port 1 (Differential) — Port 3 _ _
Sds31 (Single-ended) Transmission Sds31 = (831 - S41)/V2
Port 2 (Differential) — Port 3 _ _
Sds32 (Single-ended) Transmission Sds32 = (831 - S42)/V2
Port 2 (Common) — Port 1 _
Scs12 (Single-ended) Transmission Ssc12 = (813 + S23)/V2
Port 3 (Common) — Port 1 _
Scs13 (Single-ended) Transmission Ssc13 = (S14 + S24)/V2
Port 1 (Common) — Port 3 _
Scs31 (Single-ended) Transmission Ssc31 = (831 + S41)/V2
Port 2 (Common) — Port 3 _
Scs32 (Single-ended) Transmission Ssc32 = (S32 + S42)/N2
Port 2 (Single-ended) — Port 1 _ _
Ssd12 (Differential) Transmission Ssd12 = (S12 - S13)/V2
Port 3 (Single-ended) — Port 1 _ _
Ssd13 (Differentia?l) Transmission Ssd13 = (S13 - S14/V2
Port 1 (Single-ended) — Port 2 _ _
Ssd21 (Differentiagl) Transmission Ssd21 = (S31 - S32)/V2
Port 3 (Single-ended) — Port 2 _ _
Ssd23 (Differentiagl) Transmission Ssd23 = (523 - S2dh/N2
Ssc12 Port 2 (Single-ended) — Port 1 Ssd31 = (S41 — S42)/v2

(Common) Transmission

48
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Parameter Definition Formula

Port 3 (Single-ended) — Port 1 _
Ssc13 (Common)gTransmission Ssc12 = (S12 + S13)/V2

Port 1 (Single-ended) — Port 2 _
Ssc21 (Common) Transmission Ssc13 = (S13 + S14)/v2

Port 3 (Single-ended) — Port 2 _
Ssc23 (Common) Transmission Ssc21 = (S31 + S32)/V2

9.2.2 Topology

The 2-port instrument supports only the BAL topology type. Other types of
topologies are supported by the instrument model with 4 ports and above. The
physical ports cannot be mapped repeatedly, otherwise the configuration is invalid.
The topology configuration is valid for the channel level.

The relationship between the logical ports and the physical ports is based on the
selected topology type. The mapping rules for the physical ports are as follows:

«  Single-ended logical ports (SE, Single-ended): maps to 1 physical port.

. Balanced logical ports (BAL, Balance): maps to 2 non-overlapping physical ports
(distinguishing positive line/negative line).

. Duplicate mapping of physical ports is not allowed; otherwise, the configuration

will be invalid.

BAL (Single-ended Balanced Port Component)

Only 1 balanced port is included. It supports the reflection characteristic
measurement, without transmission class parameters.

Balanced
PRLE i DUT
portb : +——

+  Port Mapping:

Physical ports (Port a(+) and Port b(-)) are mapped to one balanced logical port
BALT.

. Measurement Parameters: Sdd11, Scc11, Sdc11, Scd11 (Reflection class)
BAL-BAL (Balanced-Balanced Port Component)

Both inputs and outputs are balanced ports, supporting full reflection, transmission,
and mode conversion measurements.
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Balanced Balanced
A £

orta f tportc

borta ¢ DUT ;

porth & ) ;portd
t;_,f b -

+  Port Mapping:

Physical ports (Port a(+) and Port b(-)) are mapped to one balanced logical port
BAL1(input).

Port c(+) and Port d(-) are mapped to one balanced logical port BAL2(output).

. Measurement Parameters:

- Reflection parameters: Sdd11, Sdd22, Scc11, Scc22, Sdc11, Sdc22, Scd11,
and Scd22

- Transmission parameters: Sdd21, Sdd12, Scc21, Scc12, Sdc21, Sdc12, Scd21,
and Scd12

- Imbalance/CMRR: Imbal1, Imbal2, and CMRR

BAL-SE (Balanced-Single-ended Port Component)

Balanced port as input and single-ended port as output, supporting balance —
single-ended conversion-related measurements.

Balanced Single-ended

"+ |
ota | +——
. i1 | DUT port ¢
portb | —

. Port Mapping:

Physical ports (Port a(+) and Port b(-)) are mapped to one balanced logical port
BAL1(input).

Port c is mapped to 1 single-ended logical port SE2(output).

. Measurement Parameters:

- Reflection parameters: Sdd11, Scc11, and Sss22
- Transmission parameters: Sds12, Scs12, Ssd21, and Ssc21

- Imbalance/CMRR: Imbal, CMRR1, and CMRR2

50
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SE-BAL (Single-ended-Balanced Port Component)

Single-ended port as input and balanced port (default topology type) as output,
supporting single-ended-balanced conversion-related measurements.

port &

+  Port Mapping:

Single-ended

Balanced

DUT

{4
— | portb

~T

‘ :’ partc

e

Physical port (Port a) is mapped to 1 single-ended logical port SE1(input).

Port b(+) and Port c(-) are mapped to 1 balanced logical port BAL2(input).

. Measurement Parameters:

- Reflection parameters: Sss11, Sdd22, Scc22, Sdc22, and Scd22

- Transmission parameters: Ssd12, Ssc12, Sds21, and Scs21

- Imbalance/CMRR: Imbal, CMRR1, and CMRR2

SE-SE-BAL (Single-ended-Single-ended-Balanced Port Component)

2 independent single-ended ports as inputs and 1 balanced port as output,
supporting single-ended-single-ended-balanced conversion-related measurements.

port @
port b

+  Port Mapping:

Single-ended

Balanced
i

DUT

i+
— {portc

Single-ended

—— portd
y =

Physical port Port a is mapped to 1 single-ended logical port SE1(input).

Port b is mapped to 1 single-ended logical port SE2(input).

Port c(+) and Port d(-) are mapped to 1 balanced logical port BAL1(output).

. Measurement Parameters:

- Reflection parameters: Sss11, Sss22, Sdd33, Scc33, Sdc33, and Scd33

- Transmission parameters: Ssd13, Ssd23, Ssc13, Ssc23, Sds31, Sds32, Scs31,

and Scs32
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9.2.3

- Imbalance/CMRR: Imbal1, Imbal2, CMRR1, and CMRR2

BAL-SE-SE (Balanced-Single-ended-Single-ended Port Component)

1 balanced port as input and 2 independent single-ended ports as outputs,
supporting balanced-single-ended-single-ended conversion-related measurements.

Balanced Single-ended
port a —— * DUT - port ¢
porth | ——j - portd

e Single-ended

+  Port Mapping:

Physical ports Port a(+) and Port b(-) are mapped to 1 balanced logical port
BAL1(input).

Port c is mapped to 1 single-ended logical port SE2(output).
Port d is mapped to 1 single-ended logical port SE3(output).

. Measurement Parameters:
- Reflection parameters: Sdd11, Scc11, Sdc11, Scd11, Sss22, and Sss33

- Transmission parameters: Sds12, Sds13, Scs12, Scs13, Ssd21, Ssd31, Ssc21,

and Ssc31

- Imbalance/CMRR: Imbal1, Imbal2, CMRR1, and CMRR2

Imbalance/CMRR

Imbalance of the Balanced Ports

Imbalance (Imba) of the balanced port is an indicator to measure the degree of
matching between the two physical ports that constitute a balanced port.

Imba can be analyzed from three parameters: Gain, phase, and system performance.
«  Differential and common-mode gain

The differential-mode gain describes the signal response of the balanced port
for the differential mode (A-B) stimulus. The common-mode gain describes the
signal response of the balanced port for the common-mode ((A+B)/2) stimulus.
The ideal balanced port should have a high differential mode gain and a low
common mode gain.

. Phase imbalance

52
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measures the phase difference between two physical ports. Ideally, the phases of
the two ports should be completely opposite, with a difference of 180 degrees.

. Common mode rejection ratio (CMRR)

CMRR is the ratio of transmission characteristics of balanced port differential
mode to that of common mode. A higher CMRR value indicates lower imbalance
of the balanced port (good port match); otherwise, a lower CMRR value indicates
higher imbalance of the balanced port (port mismatch).

The calculation of Imba is strongly related to the balanced topology of the DUT, and
is only applicable to vector network measuring devices with 4 ports and above.

Table 9.4 Imbalance

Topology

Formula

Remarks

BAL

Imbal = Sba/Sbb

Where, a and b are two physical
ports of the same balanced port
Sba = single-ended transmission
from Port b to Port a.
Sbb = single-ended reflection from
Port b to Port b.
Transmission/Reflection ratio of two
Bh sical channels on the same
alanced port

BAL-SE

Imbal = Sca/Scb

c indicates the single-ended logical
port.

a and b are two physical ports of
the balanced port.

Sca = single-ended transmission
from Port ¢ to Port a.

Scb = single-ended transmission
from Port ¢ to Port b.

SE-BAL

Imbal = Sba/Sca

a indicates the single-ended logical
port.

b and c are two physical ports of
the balanced port.

Sba = single-ended transmission
from Port b to Port a.

Sca = single-ended transmission
from Port ¢ to Port a.

BAL-BAL

Imbal1 = (Sac - Sad)/(Sbc
- Shd)

Imbal2 = (Sca - Scb)
/(Sda - Sdb)

a and b are the physical ports of

Balanced Port 1.

c and d are the physical ports of

Balanced Port 2.

Imbal1 is the transmission path

from Balanced Port 1 to Balanced

Port 2.

Imbal?2 is the transmission path

gom1BaIanced Port 2 to Balanced
ort 1.

SE-SE-BAL

Same as BAL-BAL

a and b are single-ended logical

ports.

c and d are physical ports of the

balanced port.

Corresponds to the transmission

Bath from single-ended port to
alanced port.
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Topology

Formula

Remarks

BAL-SE-SE

Same as BAL-BAL

« aand b are two physical ports of
the balanced port.

e candd are two single-ended
logical ports.

e Corresponds to the transmission
path from balanced port to single-
ended port.

CMRR

CMRR is the ratio of transmission characteristics of balanced port differential mode
(d) to that of the common mode (c). CMRR reflects the device's rejection for the
common mode signal. The higher the ratio, the greater the differential device's
rejection for the common mode, capable of transmitting the differential signals
efficiently. On the contrary, the lower the CMRR value, the more vulnerable to
common mode noise interference.

CMRR is strongly related to the balanced S-parameters and the balanced topology of

the DUT.

Topology

CMRR Formula

Description

BAL

N/A

Port reflection characteristics only,
without differential/common mode
él n;étransmwswn, unable to calculate

BAL-BAL

CMRR = Scc21/Sdd21

Sdd?21 indicates the transmission class
balanced S-parameter in differential
mode; Scc21 indicates the same path
transmission class balanced S-parameter
in common mode, and is the ratio of the
transmission of core differential mode to
common mode.

BAL-SE

CMRRT = Ssc21/Ssd21
CMRR2 = Scs12/Sds12

Each corresponds to the bidirectional
transmission path between the balanced
port and the single-ended port. They are
ratios of transmission class balanced S-
parameter of the differential mode to
tha'ﬁlof the common mode for the same
path.

SE-BAL

CMRRT = Scs21/Sds21
CMRR2 = Ssc12/Ssd12

Corresponds to the bidirectional
transmission path between the single-
ended port and the balanced port.

BAL-SE-SE

CMRR1 = Scs12/Sds12
CMRR2 = Scs13/Sds13

Corresponds to the independent
transmission path between the balanced
port and two single-ended ports.

SE-SE-BAL

CMRR1 = Scs31/Sds31
CMRR2 = Scs32/Sds32

Corresponds to the independent
transmission path between two single-
ended ports and the balanced port.
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9.3 Meas Setup

Parameter Conversion

Refer to descriptions in in Math > Analysis menu. When you
modify the settings in parameter conversion in either Meas Setup or Analysis sub-
menu of Math, the modification will be global to parameter conversion in both of the
menus.

Correction

For the correction function, refer to descriptions in

(click Calibration > Main to enter the calibration menu). When you modify the
correction state in any function menu, the modification will be global to correction
settings in other menus.

Trace Hold

For the trace hold function, refer to descriptions in in Trace section (click
Trace > Trace Setup > Trace Hold). When you modify the Trace hold function in any
function menu, the modification will be global to trace hold settings in other menus.
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10.1

Data Format

The data format is a way of presenting measurement data in the form of graphs.
Select the desired data format that matches the test device.

In the Format menu, click the desired data format to set the format for the current
active trace.

Rectangular Display Formats

Rectangular display formats (also known as Cartesian coordinates, X/Y, or rectilinear).
The rectangular display is especially useful for displaying the frequency response
information of the test device.

«  X-axis: displays stimulus data (frequency, data, or time).

«  Y-axis: displays measurement data.

Log Mag

Displays the magnitude of the signal, without phase. Y-axis is represented in dB,
wrapping a large range of values for easy scaling, convenient to present large
variations of the signal. It is applicable to the signal with a large magnitude or large
variations as the Log Mag format can better display the details of the signal.

Typical application: used in return loss, insertion loss or gain measurement.
Lin Mag

Y-axis displays positive values of the signal magnitude only, without unit. It is
applicable to the calibrated measurement with the Watts (W) or Volt (V) as the unit.
For the measurement concerning the power or voltage item, if you have completed
the calibration, using this format can directly obtain the magnitude value in linear
form.

Typical measurement: reflection and transmission coefficients (magnitude), time
domain transfer.

Group Delay

Displays the signal transmission (propagation) time through a device. Y-axis: Time in
seconds.

Typical measurement: As the transmission speed of the frequency components of the
signal in the medium is different, the time delay occurs, resulting in phase deviation.
The phase deviation between various frequency components changes with the
frequency, causing signal distortion. If the group delay of a system is a constant value
for all the frequency span, it indicates that the system is an all-pass system, meaning
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that the transmission speed at all frequencies is the same, which will not cause signal
distortion.

Phase

«  Measurement principle: measures the phase of the signal relative to the
calibration reference plane with a range of +/- 180 degrees.

- Display information: displays only phase, without magnitude.

«  Y-axis unit: phase in degrees.

«  Trace characteristics: When phase values exceed +180°, the trace wraps every
180 degrees to facilitate observation and analysis of phase variations within the
limited display range.

This prevents large discontinuities in the displayed phase values, easier to
observe phase variation and scaling, better for detailed analysis of the phase
variation.

«  Typical measurement: It mainly detects the deviation of the signal from the
linear phase, describing the linear variation of the phase along with the time or

frequency during system transmission or processing.

Unwrapped phase

Similar with the phase format, but without 180 degrees wrapping. Phase is
unwrapped by comparing the phase from one data point to the next. If the phase
difference between two points is greater than 180 degrees, or if the phase of the first
data point is greater than 180 degrees from DC, then the phase measurement is
probably inaccurate.

Positive Phase

Displays the phase wrapped from 0 to +360 degrees. That is, the phase value will not
be a negative value. If it exceeds 360 degrees, it will restart from 0 degree.

SWR

Displays reflection measurement data calculated from the formula (1 + p)/(1 - p),
wherein, p is reflection coefficient. It's valid only for reflection measurements, used for
analyzing the relevant characteristics of the reflection signal. The Y-axis is unitless (U)
for ratioed measurements.

Typical measurement: Standing Wave Ratio (SWR) is used to evaluate the match
between transmission line and load. It is an important evaluation parameter for
impedance match in RF and microwave systems. When SWR = 1, it indicates that it is
totally matched, which considers as an ideal condition.
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Real

Displays only the real (resistive) part of the measured complex data. It can be positive
and negative values. The Y-axis is unitless.

Typical measurement: time domain, auxiliary input voltage signal for service
purposes.

Imaginary

Displays only the imaginary (reactive) part of the measured data. It can be positive
and negative values. Y-axis is unitless.

Typical measurement: impedance for designing matching network.

Polar

Polar format is used to view the magnitude and phase of the reflection coefficient (I')
from the S11 or S22 measurement.

You can use markers to display the following information.
. Linear magnitude (in units) or log magnitude (in dB)
. Phase (in degrees)

The distance between the polar trace and the polar origin represents the magnitude
(linear) of the measurement results. The position to the origin represents magnitude
(linear); the angle deviation from the positive X-axis counterclockwise represents
phase.

e ) _ Reflection
=% --\- =33 COefficient
T Magnitude
Phase Angle -
of Reflected

Signal

«  The dashed circles represent reflection coefficient. The outermost circle
represents a reflection coefficient (') of 1, or total reflected signal. The center of

the circle represents a reflection coefficient (I') of 0, or no reflected signal.

58

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



Data Format
EN

e The radial lines show the phase angle of reflected signal. The right-most position
corresponds to zero phase angle, (that is, the reflected signal is at the same
phase as the incident signal).

. Phase deviation of 90°, £180°, and -90° correspond to the top, left-most, and

bottom positions on the polar display, respectively.

10.3  Smith

The Smith chart is a tool used to analyze the impedance and reflection coefficient
graphically. In a Smith chart, the rectilinear impedance plane is reshaped to form a
circular grid, mapping the complex reflection coefficient (I') to the test device's
impedance.

With the Smith chart, you can read the series resistance (R) and reactance (X) of the
test device, i.e, (R +/X).

. Resistance (expressed in Q)

. Reactance as an equivalent capacitance (expressed in £) or inductance

(expressed in H)

The Smith Chart is widely used in the design, debugging, and troubleshooting of the
impedance match in the RF/microwave circuit.

Constant X
+X
0 +Roo—
X
>
Constant R
Rectilinear Impedance Plane Smith Chart

. Every point on the Smith Chart represents a complex impedance made up of a
real resistance (R) and an imaginary reactance (R + jX).

«  The horizontal axis (the solid line) is the real portion of the impedance - the
resistance. The center of the horizontal axis always represents the system
impedance. To the far right, the value is infinite ohms (open). To the far left, the

value is zero ohms (short).
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«  The dashed circles that intersect the horizontal axis represent constant
resistance.

«  The dashed arcs that are tangent to the horizontal axis represent constant
reactance.

e The upper half of the Smith chart is the area where the reactive component is
positive and therefore inductive.

»  The lower half of the Smith chart is the area where the reactive component is

Negative and therefore capacitive.

10.4 Inverted Smith

Inverted Smith also known as Admittance, is a tool dedicated for admittance analysis.
It is similar with the standard Smith chart, but it analyzes the admittance rather than
resistance.

The core principle of the inverted Smith Chart is to convert "impedance analysis" into
"admittance analysis", where admittance Y = G + jB (G is conductance, B is
susceptance) is the reciprocal of impedance.

«  The plot graticule is reversed right-to-left.
. Admittance (in units of siemens) instead of resistance.

Constant
Reactance

j50
Constant

1100 Resistance

j2s

!

ino <
‘ Inductive

2 250

Capacitive

-j10 ;:I-izso |

-j100
i System
-|50 Impedance

60 Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



Marker
EN

11 Marker

Marker is a triangle sign, which is used for marking the point on the trace. Markers
provide readouts of the frequency of each point on the trace and measurement
values. The values vary based on the measurement parameters of the trace and the
trace format.

11.1 Marker 1-7/Marker 8-15

Up to 15 normal markers (Marker1 to Marker15) and one reference marker are
available for each trace. By default, Marker 1 is selected.

S11 LogM 10.00dB/ 0.00 dB
) ¢ 1.417 GHz -1.124 d8
40 2: . 1.828 dB
a0 =R: dB
20 : ' )
10
0

10
20
-0
-40
-50

Start 10.0000 MHz ——
art -10 dBm CW 1.00000 GHz

Add/Delete a Marker

Check the checkbox of the specified marker, and the checkbox is highlighted in green,
then the marker is added on the trace. Uncheck the checkbox of the specified marker
to remove the marker from the screen.

The added marker will automatically become the current active marker. The marker
appears above the current trace, displayed as "V +marker number". All of the other
markers inactive on the same trace appear below the trace, displayed as "A+marker
number". Click the specified triangle marker icon on the trace in the window to make
it become the active marker. You can also click the specified marker from the drop-
down list of markers to select it as the active marker.

The marker data are displayed at the right section of the window where the trace is
located. One window can display data of up to 20 traces. The marker data contain the
following information.

. Marker number. If ">" is added before the marker number, it indicates that the
marker is currently active.

«  Trace where the marker is located. You can identify the trace by recognizing the

color of the marker. The marker color is the same as the trace color.
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11.2

. Marker's stimulus data (X-axis) and response data (Y-axis). The data format of

the marker is the same as that of trace where the marker is located.

Move the Marker

Move the marker with the following methods. During moving, the marker will always
move along with the trace. The marker icon can be overlapped with each other.

»  Click the selected marker to set its X-axis value with the numeric keypad. Then

the marker is moved to the specified position on the trace.

e Click the selected marker to set its X-axis value with the knob. Then the marker is
moved to the specified position on the trace.

«  Select the marker, then drag the marker to move it to the specified position on
the trace. This method is not allowed when the data format of the trace is

"Smith", "Inverted Smith", or "Polar".

The marker icon can be overlapped. Move the marker left and right, and the marker
will always move along the trace.

Reference Marker

Check the checkbox of "Reference”, the checkbox is highlighted in green, then a
reference marker is added on the trace. Uncheck the checkbox of "Reference”, then
the reference marker is removed from the screen.

By default, the reference marker is created at the position where the current normal
marker is located, but opposite with each other. If no normal marker is created on the
current trace, then the reference marker is created in the central position of the trace,
displayed as "R". The reference marker data (marked as ">R") are displayed at the
right section of the window where the trace is located. The method on how to move
the reference marker is the same as that for the normal marker.

Marker Setup

Delta

Used to measure the difference between the reference point and a certain point on
the trace, including the stimulus delta (X-axis value) and response delta (Y-axis value).
By default, Delta is disabled. The delta marker value is displayed at the upper-right
corner of the window or displayed in the marker table. The delta marker is displayed
as "A+marker number".
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If a reference marker already exists for the current trace, when "Delta" is enabled,
it calculates the difference between the current active marker and the reference
marker. If the reference marker is the current active marker, then the Delta
function is disabled.

If no reference marker exists on the current trace, when "Delta" is enabled, create
a reference marker in the center position of the trace, then adjust the positions

of the reference marker and the active marker.

3.894 GHz 8.597 dB
4.727 CHz ~1.856 dB
6.878 GHz 2.445 dB

N
R

-

»Ch 1: Start 10.0000 MHz —— Stop 8.50000 GHz

Stimulus Response

When you change the position of the Delta marker, the position of the reference
marker remains unchanged, but the frequency (or time) difference between the
two markers will change along with it.

The frequency (or Power) difference between the two markers and the

measurement values difference A are displayed on the screen.

Discrete

Used to display values at only the discrete points where data is measured.

OFF: By default, it is disabled. The marker readouts of all the data points
measured on the trace are displayed.

ON: Displays values at only the discrete points where data is measured. The
marker readouts of data values that are interpolated from the data points will

not be displayed. The discrete points where data is measured are determined by
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Type

. Normal: The marker has a fixed stimulus position (X-axis value), and by default,
the response position (Y-axis value) of the marker changes with the trace data.

«  Fixed: Causes the marker to have a fixed X-axis and Y-axis position based on its
placement on the trace when it was set to fixed. It does NOT move with trace
data amplitude. It can be scrolled left and right on the X-axis by changing the

marker stimulus value.

Format

The newly created marker use the trace data format by default. If you want to modify
the data format of the marker, the following formats are available.

Trace Default, Linear Magnitude, Log Magnitude, Phase, Group Delay, Real, Imaginary,
SWR, Log/Phase, Lin/Phase, Real/Imag, R + jX, and G + jB. For details, refer to

Coupling Mode

The coupled marker function cause markers on different traces to line up with the
markers on the selected trace. When you move the specified marker, all the other
markers that are coupled with the marker will be moved together.

Markers are coupled by marker number. If the x-axis domain of different traces is the
same (e.g., frequency or power), then coupling occurs to the markers with the same
marker number on these traces. Trace markers in a different x-axis domain will not be
coupled.

The available coupling modes include:
e OFF: disables the marker coupling.

«  Channel: By default, a marker on one trace is coupled to the same numbered

markers on traces which share the same channel number as the original trace.

«  All: A marker on one trace is coupled to the same numbered markers on all

channels, all windows, and all traces.
Marker Table

. OFF: By default, it is disabled. The marker table will not be displayed.
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ON:when it is enabled, the marker table displaying all the marker data on the
current active trace is displayed below the trace window, including the marker

number, stimulus value, and response value.

Stimulus Response

1.641 GHz -0.857 dB
2.991 GHz -1.643 dB
5.496 GHz -2.445 dB

All Off

Click All Off to disable the display of all the markers on the current active trace. The
coupled markers are also disabled.

11.3 Marker Display

Symbol Above

e OFF: By default, the active marker is displayed above the trace and the non-

active marker is displayed below the trace.

«  ON: All the marker symbols are displayed above the trace. The active marker is
filled solid.

Symbol

Sets the marker symbols. By default, it is Triangle. You can also select "Flag" or "Line".

. "Line" is not available to choose when the data format of the trace is "Smith",

"Inverted Smith", or "Polar".

«  Symbols can be set independently for each window.

Active Trace Readouts Only

«  OFF: By default, all the marker readouts of all the traces are displayed at the
upper-right corner of the window.

. ON: When it is enabled, only the marker readouts of the current active traces are

displayed at the upper-right corner of the window.
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11.4

Show Readouts

ON: By default, the marker readouts of the traces are displayed at the upper-
right corner of the window.
OFF: When it is enabled, marker readouts of the traces will not be displayed in

the window.

Readouts Per Trace

Sets the quantity of marker readouts to show in the window for each trace. By default,
up to 5 readouts per trace and 20 readouts for each window can be displayed.

Marker Functions

The marker functions allow you to make stimulus settings with the current active
marker. You can make a quick set of the following values.

Marker -> Start:

Sets the position (X-axis) of the current active marker to the start value of the
sweep.

Marker -> Stop:

Sets the position (X-axis) of the current active marker to the stop value of the
sweep.

Marker -> Center:

Sets the position (X-axis) of the current active marker to the center value of the
sweep (middle value between the start value and stop value of the sweep).

Marker -> Ref Level:

Sets the response value (Y-axis) of the current active marker to the
of the current trace.

Marker -> Span: Sets the span between the current active marker and

to the sweep span. It is unavailable if there is no reference marker.
Marker -> Delay:

The phase slope at the active marker stimulus position is used to adjust the line
length to the receiver input. This effectively flattens the phase trace around the
active marker.

Additional adjustments are required on devices without constant
over the measured frequency span. This feature adds phase delay
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to a variation in phase versus frequency; therefore, it is only applicable for
ratioed measurements.

«  Marker -> CW Frequency: When the X-axis is frequency, set the position of the
current active marker to . After performing this operation to
change the CW frequency, enable to apply the modified CW

frequency. It is invalid when the current X-axis is not frequency.
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12 Search

Performs search on the current active trace based on the set conditions and marks it

with the marker. Before using the search function, create a marker for the current
active trace, otherwise, some of the search function menus may be grayed out and
disabled.

12.1 Main

Max

Click Max, then the current active marker moves to the point with the max.
measurement value on the current active trace.

Min
Click Min, then the current active marker moves to the point with the min.
measurement value on the current active trace.

Search Domain

Defines the marker on the trace to search within the specified span. Each marker can
be configured with a search domain, and multiple markers can share one search
domain.

Click the drop-down button of Search Domain to select the specified span.

e Full Span: By default, it is full span. That is the whole X-axis, which is the same as
the sweep range of the trace itself.

«  User 1 to User 16: searches within the user-defined span. The X-axis of the

marker is defined within the set search domain.

At most, 16 user-defined search domains can be set. You need to set Domain
Start and Domain Stop for each user-defined search domain. Each user-defined
domain is independent of each other, and the user-defined domains can overlap
with each other. When the search domain is set to the user-defined domain
other than "Full Span”, a pair of smaller triangles appear automatically in the X-
axis to identify the search domain of the current active marker.
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Tracking
When you set the tracking condition, the VNA device will perform the search
operation based on the current search conditions and search domain. Once the target
point is found, the marker will locate it immediately. The marker position will move
along with the update of the trace data.
Click the drop-down button of Tracking to set the tracking conditions for the current
active marker. The tracking conditions include:
«  Off: By default, tracking function is disabled.
. Max: The marker moves to the maximum response data value (Y-axis value)
within the search domain.
. Max: The marker moves to the minimum response data value (Y-axis value)
within the search domain.
. Peak: Related to the peak search type. For details, refer to
«  Target: Related to the target search type. For details, refer to
. Multi Peak: The marker moves to the multi-peak search result position on the
trace based on the search domain. For details, refer to
. Multi Target: The marker moves to the multi-target search result position on the
trace based on the search domain. For details, refer to
NOTE
.
é . For different markers on the same trace, they can be set to Max, Min, Peak, and Target

tracking. If they are set to Multi Peak or Multi Target tracking, then other tracking settings
are invalid. all the markers share the same tracking.

. The markers that have enabled the tracking function will not affected by marker coupling.
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12.2 Peak

In the Search menu, click Peak to enter the peak search setting sub-menu. Before
executing the peak search, set the search condition and search type first.

Peak Right Search/Peak Left Search

«  Click Peak Left Search to search for the nearest peak which is located at the left
side of the current peak and meets the peak search condition.
+  Click Peak Right Search to search for the nearest peak which is located at the

right side of the current peak and meets the peak search condition.

Next Peak Search

Click Next Peak Search to search for the peak whose amplitude on the trace is next
to that of the current peak and meets the peak search condition. Once found, the
current active marker will move to the position and marks it.

Peak Polarity

«  Positive (default): searches for the positive peak, which refers to a peak whose
measured value is greater than those of the measurement points on either side
of it.

. Negative: searches for the negative peak, which refers to a peak whose
measured value is is smaller than those of the measurement points on either
side of it.

. Both: A peak whose measured value is smaller and greater than those of the
measurement points on either side of it. Both the positive peak and negative

peak are considered as valid peaks.

Peak Threshold

Related to the "Peak Polarity" setting.

. For the positive peak (positive polarity), only the peaks whose measured values
are greater than threshold can be considered as valid.

. For the negative peak (negative polarity), only the peaks whose measured values

are smaller than threshold can be considered as valid.

70 Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



EN

Search

12.3

«  When the peak polarity is set to Both, the threshold value is not used to judge

the valid peak.

Peak Excursion

The peak excursion is the difference between the peak measured value and the
measured value of the adjacent peak of the opposite polarity. Only the peaks whose
peak excursion value is greater than the set peak value can be considered as valid.

Tracking

For the tracking function, refer to descriptions about tracking function specified in
section.

Peak Search

First set the search conditions for the valid peak, then click Peak Search to perform
the peak search. Once the valid peak is found on the trace, the current active marker
will move to the position and marks it. When no peak meets the specified peak search
condition is found, the position of the marker remains unchanged.

Target

The target search function searches for a target that matches the pre-defined target
value and transition types (positive, negative, or both) and then moves the marker to
that target.

In the Search menu, click Target to enter target search setting sub-menu. Before
executing the target search, set the search condition and search type first.

Target Right/Left Search

«  Target Right Search: The marker moves to the next valid target to the right of the
first target encountered.
»  Target Left Search: The marker moves to the next valid target to the left of the

first target encountered.

Target Value

The target value refers to the searched response value (Y-axis value). If the response
value of a certain point on the trace equals the target value, then the data point is the
target point to be searched for.
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12.4

Target Transition

«  Positive: The measured value at the right side of the target point is greater than
that at the left side of the target point.

*  Negative: The measured value at the right side of the target point is smaller than
that at the left side of the target point.

. Both: Both the positive and negative transition types are considered as valid

target. It is the default target transition.

Tracking

For the tracking function, refer to descriptions about tracking function specified in

Target Search

After configuring the target value, target transition, and search domain, click Target
Search to perform the target search. Once the target point is found on the trace, the
current active marker will move to the position and marks it.

Multi Peak & Target

Multi Peak Search

The multi peak search function enables you to display markers on multiple peaks on
traces based on the multi peak excursion and multi peak polarity settings. Before
executing the multi peak search, set the following parameters to define a valid peak.

. Multi Peak Threshold: Minimum amplitude (in dB). To be considered valid, the
peak must be above the threshold level. The valley on either side can be below
the threshold level.

. Multi Peak Excursion: The vertical distance (in dB) between the peak and the
valleys on both sides. To be considered a peak, data values must "fall off" from
the peak on both sides by the excursion value.

«  Multi Peak Polarity: Positive, negative, and both. For details, refer to

in Peak Search section.

After configuring the above parameters, click Multi Peak to start searching from the
start position of the search domain to the right to search out all the valid peaks and
marks them with the marker.
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Up to 16 markers (15 normal markers and 1 reference marker) can be displayed on a
trace. When the number of valid peaks exceeds 16, only the first 16 valid peaks can be
searched to be displayed.

Multi Target Search

The multi target function searches for a target that matches the pre-defined muti
target value and multi target transition. Before executing the multi target search, set
the following parameters.

. Multi Target Value: sets the response value (Y-axis value) of the search target.
The data format and unit of the target value are the same as that of the current

trace.

«  Multi Target Transition: Positive, negative, and both. For details, refer to

in Target Search section.

After configuring the above parameters, click Multi Target to start searching from the
start position of the search domain to the right to search out all the valid targets and
marks them with the marker.

Up to 16 markers (15 normal markers and 1 reference marker) can be displayed on a
trace. When the number of valid targets exceeds 16, only the first 16 valid targets can
be searched to be displayed.
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Tracking

The tracking function causes the marker to search for the specified search condition
with each new sweep. By default, it is OFF.

When the tracking function is enabled, the search begins with the first sweep based
on the current search type and domain information. Therefore, before using the data,
ensure that the search condition is in the desired state. If tracking is selected for a
marker, you are not allowed to manually modify the stimulus settings for the marker.
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13 Calibration

In the vector network analysis, the test system (including the DUT, cable, connector,
fixture, and etc.) inevitably may bring about system errors, resulting in the fact that
the raw measurement value of the DUT cannot directly represent its true
characteristics. Therefore, the VNA is equipped with a series of calibration features
such as calibration compensation, fixture simulation, and port extension, to remove

the identified errors from the measurement results accurately.

VNA provides a series of calibration solutions to address different application
scenarios.

e The calibration compensation is mainly used to remove the inherent basic errors

in the test system, which is the basis for achieving high-precision measurement.

«  The fixture de-embedding function is intended to remove the effects of the test
fixture on the measurement effectively and restore the true performance of the

DUT.

«  The port extension feature is applicable in compensating the amplitude offset
and phase deviation caused by the length of the test cable to ensure the

accuracy of the measurement.

The above features are designed for different test demands, but the core principle is
to correct errors through S-parameters matrix and error compensation matrix
operation, mathematically compensating the system errors in the transmission path
of the measurement signal fundamentally.

Note that when multiple correction functions are enabled simultaneously, the
execution sequence of the specified function will directly affect the validity of the final
measurement results. Ensure that the sequence of the physical connection of the DUT,
the expected test network model setup and function execution are consistent. Only in
this way, can the measured data truly reflect the characteristics of the DUT.

13.1 Main

The following table lists the S-parameter calibration type supported by VNA.

Table 13.1 S-parameter Calibration Type Supported by VNA

y:rr:\sber of | calibration Type Calibration Item to be Performed
1 Response Open Open response calibration
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yglrrgber of |calibration Type Calibration Item to be Performed
(Only Response Short Short response calibration
calibrate the
reflection OSL Open, Short, and Load response calibration
parameters)
Response 1 to 2 Port 1—2 Through response calibration
Response 2 to 1 Port 2—1 Through response calibration
Enhanced response calibration
Enh Response 1to2 |«  Port 1: Open, Short, and Load
2 . Port 1—2: Through
Enhanced response calibration
Enh Response2to 1 |« Port 2: Open, Short, and Load
. Port 2—1: Through
All response calibration
SOLT . Port 1: Open, Short, and Load
. Port 2: Open, Short, and Load
. Port 1=2: Through

13.1.1 Basic Calibration

In the calibration wizard, select the desired S-parameter calibration type and
configure the relevant parameter settings to perform the S-parameter user-defined
calibration.

Click Basic Cal to enter the basic calibration interface.

cal kit, cal port, DUT connector gender, and cal type In E 4 Back Cancel

+  Connector
Selects the desired connector type from the drop-down list to select APC 3.5,
APC 2.4, APC 7, 7-16, Type F(75), Type N(75), or Type N(50).

«  CalKit
Selects the desired calibration kit model from the drop-down list based on the
currently selected connector.

If you check the checkbox of "Show all cal kits", then all of the calibration kits are
available to choose without being limited to the connector type.

. Port
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Check the checkbox of the specified port number to be calibrated, then select
the port type (Male or Female) of the DUT that connects the specified port. You
can select one or two ports (Port 1 and Port 2) to calibrate.

«  Cal Type

Selects the desired calibration type from the drop-down list based on the
currently selected port. For details, refer to

After completing the above configuration, click Next to enter the following interface.
If you haven't set the parameters well, you can click Back to go to the previous step
to configure the parameters.

Basic Cal

In the menu, you can view the currently selected port to be calibrated and the
calibration items to be performed on the specified port. The calibration items include
OPEN-M- (Open calibration measurement), SHORT-M- (Short calibration
measurement), BROADBAND LOAD-M- (Load calibration measurement), and THRU
(Through calibration measurement). Follow the procedures below to perform the
basic calibration.

1. Connect the calibration kits to the test ports of VNA properly according to the
pop-up messages.

2. Click the first calibration button, then the current calibration trace window is
displayed below the window. When "v" (a tick icon) is displayed on the button, it
indicates that this calibration item is completed.

3. Repeat Step1 and Step 2 until all the selected calibration items have been

calibrated successfully. The menu state shows below.

Basic Cal
Port1 v OPEN -8

Port2  OPEN-M-

{0 Calibraiton Done

Click Save As to enter the file management interface ( ). The
calibration configuration information of the current channel is saved to the
specified path as a file suffixed with "*.cal". Click Finish to complete this
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13.1.2

calibration, and you will exit from the current interface and go back to the main
interface of "Basic Cal". To cancel the calibration, click Cancel.

4. To perform the Isolation Calibration, click Next to enter the isolation calibration

interface, as shown below.

Basic Cal

Save As.., Cancel

Click all the isolation calibration buttons to perform calibration. After completing
the calibration, the calibration configuration file is saved to the specified path, with
the filename suffixed with "*.cal". Click Finish to complete the calibration.

Electronic Calibration

ECal is a solid-state calibration solution. Every ECal module contains electronic
standards that are automatically switched into position during a measurement
calibration. These electronic standards have been measured at the factory and the
data are stored within the memory of the ECal module. The VNA analyzer uses the
stored data, along with the measured data, to calculate the error terms for a
measurement calibration.

For the Ecal modules supported by VNA and its operation and connection methods,
refer to ECalModule User Guide.

Connect the ECal module port to the port of the analyzer. The Ecal module is
controlled and powered through a USB connection. Wear a grounded wrist strap
when making ECal calibration. Do not disconnect USB devices and test port during
ECal calibration. After connecting the ECal module properly, wait for completing
warm-up until the indicator turns green, then start to calibrate.

The procedures for calibration operation are as follows:

1. Click ECal to enter the "Select Calibration Ports and ECal Module" interface. Set the
following configuration.

Select Calibration Ports and ECal Module

wfiguration

Select 1st Port |1 Selected Cal Kit

2nd Port | 2
Serial No

Characterization

Cancel

- Select the calibration type
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Supports single port calibration or multiple ports (e.g. 2-Port) calibration. You
can select the desired port based on your DUT.

- Port Ecal configuration

Selects the desired calibration port based on the calibration type. For 2-port
calibration, you must select two different ports.

- ECal properties

After connecting properly, VNA can automatically recognize the ECal module
and obtain the module information.

2. Click Next to enter the following interface.

Electronic Calibration Step 1/ 1

Port 1 | ECAL126-35F2 SN202501001 | Port 2

Connect ECAL126-35F2 SN202501001 to Port 1 and 2

Cancel

Complete the calibration operation according to the calibration wizard.

3. After completing the measurement, the following interface is displayed. Click Save
As to save the calibration configuration file suffixed with "*.cal" to the specified
path. Click Finish to complete the calibration.
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Calibration completed in Channel 1

Press t or
er CalSet..*

13.1.3  Correction/Correction Properties

By default, the correction function is disabled. After completing the calibration or
loading the calibration files successfully, correction is performed automatically, and its
state turns out to be ON. If the instrument is not calibrated, correction cannot be
enabled.

If the instrument has not been corrected, "No Correction” displays in
below the window. After being corrected, it displays the correction state. The
following table lists the detailed information of correction state.

Number of Ports | Calibration Type Correction State

OSL C 1-Port

Response Open

Response Short

C Resp
Response 1 to 2
Response 2 to 1
2 Enh Response 1 to 2
C Enh Resp
Enh Response 2 to 1
SOLT C 2-Port

The following table lists the correction level and accuracy for different correction
state.
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Table 13.3 Correction Level

Correction

of the measurement. It does not correct for
impedance mismatches.

State Description Accuracy

C N-Port N indicates the number of fully calibrated ports. |Highest
Indicates the enhanced response calibration. It is

C Enh Resp an aggregate of a 1-port calibration and a ls_leiéﬂggt
transmission response calibration.
Open or Short circuit response calibration

C Resp It indicates correction for the frequency response | Second Lowest

No Correction |Indicates that the correction is disabled. Lowest
. Interpolated correction. For details, refer to )
C Uncertain
Changed correction. For details, refer to .
CA Uncertain

Correction Properties

After completing the correction, click Correction Properties to view the correction
related information. If the instrument has not been calibrated, this menu is grayed out

and disabled.

Correction Properties

Cal Set Name

Cal Set Version

GUID

Description

Last Modified

Calibration Information

Measurement Class

Cal Type

Cal Set Settings

Sweep Type
Start Frequency
IF Bandwidth

System

Number of Points
Stop Frequency

Port Power

Firmware Revision
VNA Model Number

VNA Serial Number
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13.1.4

Calibration Kits

Click Cal Kit to enter the "Manage Cal Kits" interface, as shown in the figure below.

Delete

Recall Workspace... Restone Default

There are multiple built-in calibration kits in the VNA.
Edit the Calibration Kits

Modifies the parameters for each calibration kit. Select one calibration kit, then click
Edit... to enter the calibration kits editing interface, as shown in the figure below.

Ecit Kit

| 850560

Impedance

Transmission Media

CoAX

Cancel

Modify the parameters according to your needs. After completing editing, click OK to
save the editing. Then exit the parameter setting interface automatically.

Basic Operations

e Copy: Select one calibration kit, then click Copy..., then the calibration kits
copying interface is displayed. Modify the parameters according to your needs.
After completing editing, click OK to copy the specified calibration kit to the
calibration kits list. Then exit the calibration kits copying interface automatically.
The newly copied calibration kit is added to the calibration kits list, with the

default filename "original calibration kit name_N". Wherein, N indicates the
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number. By default, for the first copy version of the specified calibration kit, N is
1, it increases with an increment of 1.

Import: Click Import..., then the file management interface ( ) is
displayed. Select the file suffixed with "*.xkt" from the specified path. Click
Confirm to import the specified file from the specified path. You can import the
user-defined calibration kit to the current calibration kit list. It is displayed at the
last line of the current calibration kit list. Then you can use the user-defined
calibration kit to calibrate the VNA.

Save: Select one calibration kit, then click Save... to enter the file management
interface. Save the current calibration kit and its detailed parameter settings to
the specified path, with the filename suffixed with "*.xkt".

Delete: Select one calibration kit, then click Delete, then a prompt message
prompting you whether to delete the specified calibration kit is displayed. Click
Confirm to delete the specified calibration kit from the current calibration kits

list.

Calibration Kit Workspace

In the "Manage Cal Kits" interface, the displayed "Standard Cal Kits" list is defined as
one workspace.

Save Workspace: Click Save Workspace... to enter the file management
interface. All of the calibration kits and the detailed parameters information of
each calibration kit in the current workspace are saved to the specified path, with
the filename suffixed with "*.xkw".

Recall Workspace: Click Recall Workspace... to enter the file management
interface. Select the specified file suffixed with "*xkw" from the specified path.
Click Confirm to recall the user-defined calibration kit list in replace of the
current workspace. Then you can use the specified calibration kit in the user-
defined workspace to calibrate the VNA.

Restore Default: Click this button to restore the calibration kits list and detailed

parameters of each calibration kit to the default settings.

82
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13.1.5 To Save or Recall the CalSet File

After completing the calibration, all the calibration data will be saved to the
calibration sets. The calibration sets can be applied to the channels that have the
same stimulus settings as this calibration set, thus reducing the time for performing
the calibration again. The data saved in the calibration sets include ID and
description, calibration set properties (stimulus setting, calibration type, port
association, etc.), calibration data, error term data, GUID, etc.

After completing one calibration, the data will be saved to the calibration register of
the specified channel automatically, overwriting the existing calibration data in the
register. You can save it to the specified path as a calibration sets file suffixed with

"* cal".

The saving and recalling operation of the calibration sets file can be performed in the
file management interface. For details, refer to

Save CalSet

Click Save CalSet, then the file management interface is displayed. In the interface,
set the saving path, filename, the file format "*.cal", then click Save to save the file.

Recall CalSet

Click Recall CalSet, then the file management interface is displayed. Open the
specified path and select the specified calibration sets file suffixed with "*.cal”, then
click Confirm to complete loading the file.

13.1.6 Interpolation

Calibration interpolation adjusts calibration error terms to match changes to the
stimulus parameters settings (such as freq and points) that you make after a
calibration is performed or a CalSet is applied, keeping the accuracy of the
measurement results through the interpolation algorithm, avoiding error calibration
failure arising from modifying the settings.

Enable or Disable the Interpolation

By default, interpolation is disabled. When enabled, the interpolation is enabled for
the current active measurement, but this does not necessarily mean that the
measurement is interpolated. When enabled, if you modify the following stimulus
settings, and the system deems that it is necessary to initiate interpolation operation
to keep the accuracy of the measurement, then the interpolation will be applied. If
you modify the stimulus settings while the interpolation is disabled, then
interpolation is not applied, but the error correction function (

) is automatically disabled.

Interpolation occurs (if enabled) if you change the following settings in

«  Start frequency increased
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«  Stop frequency decreased

. Number of points adjusted

TIP

Decreasing the start frequency or increasing the stop frequency will force the correction
function to be disabled.

Interpolation Calibration Accuracy

When a measurement is interpolated, the accuracy of the measurements cannot be
predicted. It may be affected significantly or not at all. Identifying measurement
errors in these cases must be determined on a case-by-case basis.

. In general, the magnitude and phase stimulus from the VNA and the response
from the DUT need to be smooth and continuous for measurement interpolation
to give accurate results.

. Significant measurement inaccuracy occurs when the phase shift response
variation between measurement points changes more than 180 degrees.

. In general, the chances of significant inaccuracy increases when interpolating
measurements under the following conditions:

- When the frequency span between measurement points becomes greater

- When the measurement frequencies are above 10 GHz where the phase

changes happen more rapidly
- When interpolating across frequency band crossings

When the interpolation algorithm encounters an abrupt or large change in the
response magnitude or phase, such as can occur at band crossings, large
interpolation errors can be included in the displayed data. These errors can be seen as
steps or spikes. If this occurs, attempt to use the following methods to avoid it.

. Disable interpolation

e Adjust the sweep measurement parameters such as decreasing the frequency

span, decreasing the sweep points, etc.

«  Create sweep segments that skip over the band crossings

84
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13.2

Display State of Interpolation Calibration

After executing the interpolation correction, the calibration status displayed in
below the window changes. The character C following a star "*" appears.

For example, "C" 2-Port".
. Interpolation Correction:

If you modify the points, increase the start frequency or decrease the
stop frequency, the interpolation correction is enabled, then the correction state
displayed in below the window shows "C™", for example, "C" 2-
Port".

+  Configuration Modification:

If one or multiple stimulus parameters such as , , or
change, the correction status shows "CA". For example, "CA 2-Port".

Port Extension

Port extensions allow you to electrically move the measurement reference plane after
you have performed a calibration. After completing the S-parameter calibration, use
the port extension to address the following problems in the test scenarios.

+  Test fixture limitation: The device is in the test fixture, making you unable to
perform a calibration directly on the device. Perform a calibration at a
convenient place, then use the port extension function to compensate for the
time delay (phase shift) and loss caused by the fixture.

«  Additional transmission line: If you have performed a calibration, and then you
decide to add a length of transmission line in the measurement configuration,
then you can use the port extension configuration to extend the length to the
specified port of the VNA.

Click Calibration > Port Extension > Port Extensions to enter the Port Extensions
interface.
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Port Extensions

Port 1 v [ Port Extension ON

—Delay ~—Loss

Dist. |[Om LossAtDC  |0dB |

Time [0s ' (Jloss1 [0dB |@Freq1 |0 Hz

Distance Unit |Meters w Loss2 iIOdB I@Freqz 0 Hz

Velocity
Velocity Factor . (] Couple to system Velocity Factor

Configure the port extensions parameters

. Port 1/2: Selects the measurement port to be used. The settings of the port
extension will affect all measurements on the active channel that are associated
with the specified port.

«  Enable or disable the port extension: Check or uncheck the checkbox of Port
Extension ON to enable or disable the port extension function.

+ Delay

Time: indicates the amount of port extension delay in time. Enter a positive or
negative value.

Dist.: indicates the amount of port extension delay in physical length. Enter a
positive or negative value.

Distance Unit: indicates the available distance units, such as Meters, Feet, and
Inches.

. Loss

- Loss at DC: Offsets the entire frequency by this value. It is used to
compensate for the loss at DC caused by the transmission line and test
fixture. To compensate for loss at DC, enter a positive value which causes
the trace to shift in the positive (up) direction.

- Loss1@Freq1: the loss and frequency parameters are used together. After
checking the checkbox of "Loss1", input a specific loss value in dB, and
specify a frequency value in Hz. Set a loss reference value at the specified
frequency point to make the calibration more accurate in the loss at the

specified frequency range.
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- Loss2@Freq2:Similar with the setting of Loss1@Freq1. Input a specific loss

value in dB and specify a frequency value in Hz.

When "Loss1" and "Loss2" are used, a curved-fit algorithm is used to
calculate the loss compensation of other points within the frequency range
to accurately calibrate the loss across the entire frequency range.

«  Velocity Factor:

For each port, set the velocity factor that applies to the medium of the device
that was inserted after the measurement calibration. For details, refer to
descriptions about velocity factor in . By default, the velocity
factor is set for only the specified port and only for port extension. After
checking the checkbox of Couple to System Velocity Factor following Velocity
Factor, the velocity factor is set for all ports.

Once the checkbox of Couple to System Velocity Factor is checked, modifying
the velocity factor value will also change the velocity factor in .
, and

Procedures for performing port extension

1. Select a calibrated S11 measurement trace. Take reflection coefficient of Port 1 as
the basic measurement.

2. Set the data format of the measurement trace to "Phase" to better observe and
adjust the phase.

3. Connect Open or Short at the calibration reference plane. View and verify the
phase readouts across the frequency range. In the ideal state, the phase shall be at
or near zero. If the phase deviation is large, check whether there is a problem in
the calibration process or hardware connection.

4. Connect the fixture or added transmission line to the measurement system in
place of the DUT. In the position where DUT is located, attach an Open or Short.

5. Adjust the delay compensation
- If the fixture or the "electrical length" of additional transmission line is known,

set the "Delay" parameter directly.
- If the fixture or the "physical length" of additional transmission line is known,

set the "Distance" parameter directly.

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved. 87



Calibration
EN

- If the extension length is unknown, increase the value of "Delay" or "Distance”
gradually to observe the phase response within the frequency span shown on
the screen. Adjust the value continuously until the phase response within the
specified frequency span becomes smooth, that is, ensure that the phase
variation is within the acceptable range. Then complete the port extension

operation.

After performing the above operations, observe whether the phase, reflection
coefficient, and other parameters at different frequency points meet the expected
values. Compare the results with the results that have not performed port extension
to confirm whether the setting is valid. If the measurement results are not ideal,
repeat the above steps and readjust the relevant parameters.

13.3 Auto Port Extensions

APE (Auto Port Extension) is an automated reference plane calibration function. By
simply connecting OPEN or SHORT standard, the system can automatically calculate
and apply delay and loss compensation parameters, accurately moving the
measurement reference plane to the standard interface. This function effectively
eliminates errors introduced by additional transmission lines and test fixtures,
significantly improving test efficiency and accuracy and avoiding complex manual
debugging.

Prerequisites for Using APE

Before executing APE, make sure the system meets the following requirements;
otherwise the feature will not be triggered or responded:

e Calibration requirements: The instrument has completed the calibration for the

S-parameters of the channel;
«  Sweep mode: The current sweep type should be set to a type other than Power;
. Feature status: Frequency offset is disabled;
. Media settings: Measurement media is not configured as Waveguide;
«  Trace requirements: No math operation is enabled on the active trace.

Click Calibration > Port Extension > Auto Port Extensions to enter the Auto Port
Extensions interface.
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Auto Port Extensions
Measure either “OPEN". “SHORT" or both Select Ports:
Measure “OPEN" Measure “SHORT" 1,2

Measure PORT —Loss

Port 1 v % Enable (] Include Losses

Adjustment for Mismatch

Frequency Span Mode- -—User Span-

@) Current Span
) Active marker

User Span

Configure the Auto Port Extensions Parameters

All the settings are configured for the channel, and take effect for all the traces of the
current channel.

. Measure Port

Specifies the test port to perform the auto port extension and controls the
on/off status of the port, which is updated synchronously as what "Select Ports"
displays.

By default, APE feature is enabled for all the test ports automatically. The Auto
Port Extensions settings apply to all measurement items associated with the port
on the active channel.

. Loss
- Include Losses
By default, it is disabled and the loss is automatically set to O; the
"Adjustment for Mismatch" is also grayed out and disabled.

When it is enabled, the system automatically calculates the loss parameters
and writes the port extension configuration to compensate for the loss of
transmission line/fixtures (including DC loss and frequency-related loss).

- Adjustment for Mismatch
By default, it is disabled. It is only available to set when "Include Losses" is
enabled. When you check the checkbox of "Adjustment for Mismatch”, the

measurement trace will be adjusted, forcing the amplitudes of all data
points < 0 dB, avoiding instability of S-parameter values in the simulation.

«  Frequency Span Mode
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Selects the frequency span range used in the calculation of APE parameters.
Three modes are available to choose:

Current Span: Calculated using the current frequency span setting for the

channel.

- Active marker: Calculated based on active marker and adjacent high
frequency point data. If no marker is currently available, the system
automatically creates a marker at the center of the frequency span.

- User Span: The start/stop frequency needs to be set manually and the
range shall not exceed the frequency span range of the current channel.

User Span

It is only available to set when you select "User Span" under the "Frequency Span
Mode". It is used to set a user-defined frequency span.

- Start: indicates start frequency of the user span. Its setting range is as
follows: Current Start Frequency of the Channel < Start < Stop Frequency.
- Stop: indicates stop frequency of the user span. Its setting range is as

follows: Start Frequency < Stop < Current Stop Frequency of the Channel.

Operation Procedures for APE

1

. Preparation

Complete the S-parameter calibration for the channel to verify that the system
meets the requirements for APE.

. Configure Parameters

Set the APE-related parameters in the APE interface, such as target test port, loss,
and frequency span.

. Connect the Standard Components

Connect Open or Short to the enabled port securely.

. Trigger the Measurement

Click "Measure OPEN" or "Measure SHORT". The system verifies the pre-conditions
before starting the measurement. If the pre-conditions are met, the measurement
will be initiated.

. System Calculation and Application

20
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The system automatically checks the history measurement records and current
configuration to select the desired calculation method.

- With the same parameter configuration, if one of the measurements of the
standard components has been performed, the second measurement
automatically triggers the OPEN+SHORT joint calculation, making the

measurement accuracy higher.

- If the parameter configurations are different, the system calculates the
measurement of the single standard component, and the results will overwrite

the history measurement data of different parameters.

After the system calculation is completed, the system automatically activates the
port extension function, and the calculated compensation parameters such as
delay, loss etc. are applied to the measurement. The trace is updated in a real-time
manner. The compensated measurement results will be presented synchronously.

6. Verify Compensation Effects

Set the data format to Phase. If the phase curve in the full range is flat, it indicates
that the port extension compensation is completed. The reference plane has been
moved to the position where the standard component is connected.

134 Fixture

The fixture is used to simulate the electrical characteristics of the fixture with the
software-based math model. With the S-parameter (scattering parameters) of the test
fixture or the calculated S-parameter based on the physical structure and material
parameters of the fixture, you can build the math models. When measuring the DUT,
the measured data obtained by the VNA contain the comprehensive characteristics of
the DUT and the fixture. The fixture feature applies the established fixture math
model to the measured data and removes the effects of the fixture from the
measurement results through math operation to obtain the true characteristics of the
DUT.

The fixture is commonly used in the testing of semiconductor and other miniature or
special encapsulated components, high-precision batch measurements of RF
components, and high-frequency signal path compensation in the high-speed
interconnected testing.

Fixture Functions

. Eliminate the effects of the fixture: Through math models, the fixture

eliminates the errors from the measurement results, such as loss, reflection, and
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13.4.1

phase deviation caused by the fixture, to obtain more accurate DUT
characteristics data.

. Circuit embedding and de-embedding: Adds (embed) or removes (de-embed)
the specified circuit to, or from the measurement.

. Port Z conversion (port reference impedance conversion): Enables the
measurement to be carried out under different impedance standards to meet

different test demands.

Test Notice

When using the fixture, avoid the error caused by the fixture to ensure the accuracy of
the calibration results.

1. Keep the fixture model parameters accurate: Deviations of the input S-
parameters of the fixture may lead to the distortion of the compensated results.

2. Keep the consistency between the fixture and the models: In the batch
measurement, if the fixture is replaced, you need to re-measure or adjust the
fixture model parameters, rather than using the original model to perform the
measurement.

3. Keep the frequency band matched: Keep the effective frequency band of the
fixture model to cover the working frequency band of the DUT.

4. Basic calibration not negligible: The fixture simulator is a compensation tool
superimposed on the basic calibration, but it cannot replace the basic calibration

(e.g. SOLT calibration) of the analyzer. Thus, basic calibration is still necessary.

Port Match

The port match feature is used to embed the specific circuit model into the
measurement results, simulating the impedance characteristics of the fixture at the
VNA port, thus reflecting the performance of the DUT in the actual working
environment accurately.

Click Port Match to enter the following interface.
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Port Match

0 ngttge Port Matching On Al (] Enable Extrapolation

[ Port 1 v | [MatchS2PFile |

S2P File

Min Frequency Max Frequency
Port Range: 10.0000 MHz 26.5000 GHz
S2P Range: N/A N/A

1. Check the checkbox of Enable Port Matching on All Ports to enable the port
matching function.

2. Click the drop-down button to select the desired VNA port to be matched.

3. Click to select "None" or "Match S2P File" from the drop-down list. When "Match
S2P File" is selected, you can select the path where to load the "*.S2P" file.

Click Open to enter the file management interface ( ), select the
desired "*.S2P" file to be loaded, then click Confirm to complete loading.

The "*.S2P" file is the S-parameter file of 2-port network, which is used to simulate
the representation of component model of the fixture in the actual test circuit.

4. When the frequency range of the loaded S2P file does not match the current
measurement range, you can check the checkbox of Enable Extrapolation, the
system will extend the values for the first and last data points in either direction
through algorithm to make it cover the frequency range of the current
measurement, ensuring the port match function works normally.

13.4.2 Port Z

The default reference impedance of VNA is 50 Q, and the characteristics impedance
of the actual DUT may have a variation from the default value, e.g. Z, = 25Q/75Q/
100Q. The port impedance conversion function converts the default reference
impedance into the actual characteristics impedance of the DUT through the built-in
math modeling algorithm; or converts the performance data under the non-default
impedance to the system default impedance's equivalence, ensuring that the actual
electrical performance of the DUT can be accurately obtained under different
impedance standards.

Process of port impedance conversion:

1. Acquire raw data: Take the system default impedance 50 Q as the base reference to

measure the DUT's raw S-parameters.
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2. Configure the target impedance: Set the actual characteristics impedance of the

DUT, that is, target impedance.

The target impedance is configured based on the DUT characteristics settings. The
key parameters are as follows:

Parameter |Definition Application Scenarios

DUT is the pure inductive component,
and only real part is required to be
configured, and the imaginary part is
by default 0.

Real Resistance component

The DUT contains parasitic
capacitance or inductance, and it is
Imaginary Reactance component necessary to configure the imaginary
part. Otherwise, the measurement
deviation will increase significantly.

3. Data conversion operation: Convert the raw data into the equivalent S-parameter

under the target impedance to output the accurate measurement results.

The Port Z configuration interface is displayed in the following figure.

Port Z

(] Enable Port Z Conversion (all ports)

Port1 v| R [500 | ix [oq

1. Check the checkbox of "Enable Port Z Conversion (all ports)" to enable the port Z.
You should also enable de-embedding. The converted impedance value is only

applicable to all the measurement trace of the current active channel.

2. Click the drop-down button to select the desired VNA port (Port 1/Port 2) to be
applied to impedance conversion.

3. Set the target impedance parameters: real part (R) and imaginary part (jX).

13.4.3 2-port DeEmbed

2-port DeEmbed feature is used to optimize the VNA measurement results. After
calibration, if a 2-port fixture (e.g. Adapter, attenuator, a long length of cables) is
added in the measurement system, they will affect the measurement results if they
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are connected between the calibration reference plane and the DUT, unable to
measure the DUT accurately. The 2-port DeEmbed feature can remove the effects of
the 2-port fixture from the measurement results and restore the true performance of
the DUT.

The de-embed operation recalls a "*.S2P" file in Touchstone format. This file contains
the electrical characteristics of a 2-port fixture or component, such as impedance and
phase. By analyzing and calculating the data in this file, in combination with the
measured data, the de-embedding feature can eliminate the effects of the fixture on
the measurement results.

Click 2-port DeEmbed to enter the following interface.

2-port DeEmbed

(] Enable De-embedding (all ports) (] Enable Extrapolation

IPort‘l v | |User Defined (S2P File) w | (CJ Reverse adapter ports

S2P File _ Open...

Network1

DUT

Min Frequency Max Frequency
Port Range: 10.0000 MHz 26.5000 GHz
S2P Range: N/A N/A

1. Check the checkbox of Enable De-embedding (all ports) to enable the port de-

embedding function.

. Click the drop-down button to select the desired VNA port (Port 1/Port 2) to be

de-embedded.

. Click to select "None" or "User Defined (S2P File)" from the drop-down list. When

"User Defined (S2P File)" is selected, you can select the path where to load the
"*.S2P" file.

Click Open to enter the file management interface ( ), select the
desired "*.S2P" file to be loaded, then click Confirm to complete loading.

The "*.S2P" file is the S-parameter file of 2-port network, which is used to simulate
the representation of component model of the fixture in the actual test circuit.

. When you use the 2-port fixture to connect the VNA and the DUT, the connection

method of the fixture may affect the accuracy of the measurement results.
"Reverse adapter ports" feature is used to adjust the port configuration between
the fixture, VNA, and DUT to adapt to the actual connection conditions.

Generally, Port 1 connects one port of the VNA, and Port 2 connects the DUT.
However, in some special test scenarios or in the fixture design, you need to
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connect Port 2 to the VNA and connect Port 1 to the DUT, at this time, you can
check the checkbox of "Reverse adapter ports” to adjust the connection method.

The reverse of the adapter ports actually changes the signal transmission path and
measurement reference direction, enabling the VNA to analyze and process
measurement data based on the new port connection configuration, thus
removing the effects of the fixture on the measurement results accurately.

. When the frequency range of the loaded S2P file does not match the current

measurement range, you can check the checkbox of Enable Extrapolation, the
system will extend the values for the first and last data points in either direction
through algorithm to make it cover the frequency range of the current
measurement, ensuring the port match function works normally.
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14 Power

Sets the power parameters of the stimulus source. In this menu, you can set the
output power of the test port within the frequency range to ensure to use the proper
stimulus power to make measurement within the specified frequency range.

Enable or Disable Power

Enables or disables whether the test port outputs the RF stimulus signal. By default, it
is enabled. The stimulus source settings are global to all the channels.

Port Power

When you set the sweep type to "Linear Frequency" or "Log Frequency” (click Sweep
> Main > Type), you can set the power at the test port.

Start Power/Stop Power

When you set the sweep type to "Power" (click Sweep > Main > Type), you can set
the start power and stop power of the sweep signal.

The start power can be greater than the stop power, which indicates that power
sweep goes from large values to small values, and no direction is required to be set.
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Avg BW

The averaging and bandwidth function is used to reduce the random noise and
improve measurement accuracy. Modifying the averaging parameters and IF

bandwidth will affect the measurement time and measurement accuracy for the
current channel.

Main

The vector network analyzer reduces the random noise on the measurement by the
following two methods.

. Reducing IF BW
e Launch sweep averaging

Sweep averaging can be more effective than reducing IF bandwidth. However,
comparing with reducing the IF bandwidth, it takes a longer time for sweep averaging
in reducing noises, especially if many averages are required. Besides, changing IF
bandwidth after calibration will result in uncertain accuracy.

IF BW

Intermediate Frequency Bandwidth (IF Bandwidth) is the width of the intermediate
frequency band produced after mixing within the vector network analyzer's receiver. It
is the bandpass width of the receiver's internal filter and represents the receiver's
ability to filter signal frequency components. Reducing the IF receiver bandwidth
reduces the random noise on the measurement. Each tenfold reduction in IF
bandwidth lowers the noise floor by 10 dB. However, narrower IF bandwidth result in
longer sweep time.

The range of the IF bandwidth is from 1 Hz to 10 MHz. By default, it is 100 kHz. The
status bar at the bottom of the screen shows the IF BW value. Here BW refers to IF
Bandwidth.

Averaging State/Averaging Times

The averaging feature performs averaging calculation on the measurement results for
several times, reducing the error arising from uncertain factors in a single
measurement, reducing the effect of random noise on the measurement results,
making the results more stable and accurate.

Check the checkbox of the Averaging menu to enable the averaging function. By
default, it is disabled. Each time you enable the averaging function, the measurement
restarts to perform the averaging operation again. If you select "Sweep" for the
averaging type, then after enabling averaging, the averaging progress (Channel No.
Avg = Average Count Completed/Total Average Counts) for the current channel is
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displayed at the lower-left part of the trace window. If you disable averaging function,
the average count progress disappears.

Average count indicates the number of counts for averaging. Its range is from 1 to
65,535 (27216 - 1). By default, it is 1.

Restart Averaging

Clears the current measurement data and restarts sweep averaging again for a new
set of measurements. All the traces of the current active channel will be replotted.

The Restart Averaging function is not applicable to Point averaging. It is only valid
when the averaging function is enabled.

Average Type

«  Point Averaging

Each data point is measured for a specified number of times, then averaged,
before going to the next data point. The point averaging type is generally used
in the scenarios where the frequency response is relatively stable or the
measurement time is short. The sweep time of the point averaging is increased
exponentially based on the average count.

*  Sweep Averaging
Computes averaging on subsequent sweeps until the required number of
averaging sweeps is performed. This averaging type can reduce the noise in the

whole frequency range, and especially effective for the measurement with fast
changing frequency response. By default, the averaging type is Sweep averaging.

Smoothing

Trace smoothing averages a number of adjacent data points to smooth the displayed
trace. The number of adjacent data points that get averaged is also known as
smoothing aperture. The trace smoothing can reduce the peak-to-peak noise on the
broadband measured data. It smooths the trace noise and will not increase
measurement time significantly.

Enable Smoothing

By default, smoothing is disabled. When enabled, smoothing is applied to the current
active trace.

As trace smoothing follows format in the data processing map, the formatted data is
smoothed. If is Polar or Smith Chart, smoothing is automatically
disabled.
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15.3

Smoothing Aperture

Specifies the percent of the swept stimulus span (X-axis) to smooth. For example, for
a trace that contains 101 data points, if the smoothing aperture is 11%, then the
number of data points that are averaged is 11. The range of the smoothing aperture
is from 0% to 25%. By default, it is 1%.

Smoothing Points

Specifies the number of adjacent data points to average. It can only be set to an odd
number. By default, it is 3.

Group Delay Aperture

Group Delay

Group delay is the time delay of the amplitude envelope of a signal as it passes
through a device or network. It represents the rate of change of phase shift with
respect to frequency, indicating how different frequency components within a signal
experience different transmission delays through the device. The group delay is a
measure of phase distortion. It describes the transit time of a signal through a device
versus frequency. If the group delay of a system is a constant value for all the
frequencies, it indicates that the transmission speed of the frequency components is
the same, which will not cause signal distortion.

The phase characteristics of a device typically consists of both linear and higher order
(deviations from linear) phase-shift components.

. Linear phase-shift component represents average signal transit time, attributed

to electrical length of test device.

. Higher-order phase-shift component represents variations in transit time for

different frequencies. It is the source of signal distortion.

For a linear time-invariant (LTI) system, the relationship between input and output can
be characterized by its frequency response.

T(w) = -d¢(w)/ dw, wherein, w indicates the angular frequency, @(w) Indicates the
frequency response;

7(f) = -d6/ df, wherein, 8 indicates phase angle; findicates the frequency.

TIP

The group delay function is only valid when the data format is Group Delay. The setting is only
valid for the current active trace.
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Group Delay Aperture

Group delay aperture typically refers to the frequency resolution of the measurement
system in group delay measurements.

During a group delay measurement, phase is measured at two closely spaced
frequencies and then computes the phase slope. The frequency interval (frequency
delta) between the two phase measurement points is called the aperture. Changing
the aperture can result in different values of group delay. The computed slope (-delta
phase / delta frequency) varies as the aperture is increased. Therefore, when you
compare group delay data, you must know the aperture that was used in
measurements.

*  Narrow aperture: provides more details in phase linearity, making measurement
susceptible to noise (smaller signal-to-noise ratio) and phase detector
resolution.

«  Wide aperture: provides less details in phase linearity, because some phase
response is averaged out or not measured, making measurement less

susceptible to noise (larger signal-to-noise ratio).

If the group delay aperture is set too large, it may lead to over-smoothing of the
measurement results, thereby missing some important phase variation details; if set
too small, it may result in increased measurement noise, affecting the stability and
accuracy of the measurement results.

The number of adjacent data points can be set using any of the following methods.
The three options set the aperture from different angles. Modifying one parameter
will affect the other two parameters.

Formula: (Aperture Points - 1) / (Sweep Points - 1) = Percent of Span

(Sweep Stop Frequency - Sweep Start Frequency) / (Sweep Points - 1) = Sweep Points
Interval

Sweep Points Interval * (Aperture Points - 1) = Aperture Frequency

«  Percent of Span: The data points within this percentage of the current frequency
span are averaged. The range is from (2 points/current number of points) to
100%. The span must contain at least two data points.

«  Points: indicates the number of adjacent data points to average. By default, it is
set to 11. It ranges from 2 to the current number of sweep points in the channel.

. Frequency: The data points within this frequency range are averaged. The

frequency range must contain at least two data points.
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When the frequency span or number of points is reduced so that the current Group
Delay Aperture is not attainable, the Aperture is adjusted to the new frequency span
or number of points.
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16 Trigger

The trigger function causes the analyzer to select the trigger source and make a
measurement.

16.1 Main

The settings in this menu are valid for the currently selected channel.

Trigger State

The trigger states includes the following types. Check the checkbox of the specified
trigger state, and the checkbox turns green, indicating it is the currently selected
trigger state.

Hold: The trigger hold state, indicating the channel does not receive any trigger

signal and the trace will not update.

«  Single: The channel receives a single trigger signal, then goes to the Hold state.
At this time, the trace updates once and then stops.

«  Groups: The channel only receives the specified number of triggers, then goes
to Hold state. The trace updates for a specified times, then stops.
The trigger times ranges from 1 to 2000000. By default, it is 1.

«  Continuous: By default, continuous trigger is selected. The channel can receive

an infinite number of trigger signals. The trace updates continuously.

Restart Trigger

Click Restart, then all the channels that stays not in "Hold" state will be triggered in
sequence based on the channel ID. Other trigger parameters of the channel remain
unchanged.

Trigger Source

Only when the analyzer is not sweeping, can a valid trigger signal be generated.

The following trigger sources are available.

«  External: receives external signals via the rear-panel TRIG IN connector as the
trigger source.

« Internal: It is the default setting for trigger source. When you select internal

trigger source, the continuous trigger signals are generated by the analyzer.
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«  Manual: When you select "Manual” trigger source, click Manual Trigger to
generate a trigger signal. You can also click the manual trigger icon on the quick

operation toolbar at the top of the screen to generate a trigger signal.

Only when you select "Manual” trigger source, can the Manual Trigger menu be
enabled and the manual trigger icon on the quick operation toolbar at the top of
the screen be valid.

Trigger Scope

Sets the scope where the trigger signal is sent. The available scopes include:

*  Global: All channels that are not in "Hold" state will receive the trigger signal.

«  Channel: default setting. Based on the channel ID, each time only one channel
that stays not in "Hold" state can receive the trigger signal in sequence. It is

recommended when you set the trigger source to Manual or External.

Trigger Mode

This option is enabled when you set Scope to "Channel" and set Source to "Manual”
or "External".

The available trigger modes include:

«  Channel: each trigger causes all the traces in the channel to be swept in the
specified order.

«  Point: each manual or external trigger causes one data point to be measured.
Subsequent triggers go to the same trace until all the data points of the trace
have completely measured. Then other traces in the same channel are swept in

the specified order.

In the Point trigger mode, when you select "Single" or "Groups" trigger state, the
trigger count is decremented by one after all data points on all traces in the
channel are measured.

«  Sweep: Each manual or external trigger signal causes all traces that share a

source port to be swept in the specified order.

When you select "Single" or "Groups" trigger state, the trigger count is
decremented by one after all traces in all directions are swept.
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16.2 Input

Only when the trigger source is set to "External”, can the input configuration be valid.
The external trigger signal is input from the rear-panel TRIG IN connector.

Global Trigger Delay

Sets the time interval during which the instrument waits to start the sweep operation
after the trigger signal that meets the trigger conditions is received. Its range from 0 s
to 3 s. By default, itis O s.

Level/Edge

Sets the trigger condition. You can select the condition where the input trigger signal
is triggered. The available choices include "High Level", "Low Level", "Positive Edge”,
and "Negative Edge".

16.3 Output

Configures the output trigger signal parameters to output from the rear-panel TRIG

OUT connector.
Enable or Disable the Trigger Output

Enables or disables outputting trigger signals from the rear-panel TRIG OUT
connector. By default, it is disabled.

Polarity

. Positive Pulse: the output pulse is the positive pulse.

. Negative Pulse: the output pulse is the negative pulse. By default, it is Negative
pulse.

Position

. Before Acquisition: sends a pulse immediately before starting the data
acquisition.

«  After Acquisition: sends a pulse immediately after completing the data
acquisition. This is the default setting.

Per Point

«  OFF: sends the trigger signal at each sweep. This is the default setting.

«  ON: sends the trigger signal when acquiring each data point.
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Pulse Duration

Indicates the pulse width of the output trigger signal. Its range is from 1.00 ys to 1 s.
By default, it is 1.00 ps.
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17 Scale

The Scale menu mainly includes the vertical scale and related settings. You can set
the scale, reference level, and reference position (and format) to determine the data
trace on the VNA screen.

Y

" 10
w 9
n 8
u 7
Reference Reference
Level 6 Position
4 5
n 4
i 3
2

Scale/Div

0 0
X

[,

17.1 Main

Auto Scale

Click Auto Scale to set value of the vertical divisions and reference value to fit the
active data trace within the grid area of the screen.

«  The analyzer determines the smallest possible scale factor that will allow all the

displayed data to fit onto 80 percent of the vertical grid.
e The reference value is auto adjusted to center the trace on the screen.

The stimulus values and reference position are not affected when performing the
auto scale operation.

Auto Scale All

Click Auto Scale All to automatically scale all data traces in the active window to fit
vertically within the grid area of the screen.

Scale

Click Scale to set the vertical scale manually. That is, set the value of the vertical
divisions of a rectangular display format.

The unit of the scale varies according to the trace data format. In Polar and Smith
formats, scale sets the value of the outer circumference.
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17.2

Reference Level

Click Reference Level to set the value of the reference line in the vertical axis in a
rectangular format. The reference level varies based on the trace data format. In Polar
and Smith formats, reference level is invalid.

Reference Position

Adjusts the position of the reference line to move it up and down in the vertical
direction. Click Reference Position to set the position of the reference line in the
vertical axis in a rectangular format manually. 0 is the bottom line of the screen and
10 is the top line. By default, it is set to 5 (middle). In Polar and Smith formats,
reference position is invalid.

Electrical Delay

Electrical Delay refers to the linear phase delay caused by the physical length and
dielectric constant when a signal transmits in the device under test. The electrical
delay of the VNA specifies the value of delay added or removed, in Time or Distance.
It can be used to compensate for the linear phase shift through a device to make the
measurement results more accurate. You can set the electrical delay independently for
each measurement trace.

Set the Electrical Delay Time/Distance

e Click Electrical Delay Time to set the electrical delay time, expressed in s.

«  Click Electrical Delay Distance to set the electrical delay distance.

Click Distance Units to set the unit of the electrical delay distance. The available
units are meter, feet, and inch.

The "Electrical Delay Time" and "Electrical Delay Distance" are correlative. Modifying
one parameter will affect the other.

Velocity Factor

Velocity Factor (VF) is used to describe the ratio of the transmission speed of
electromagnetic waves in the medium relative to the speed of light in the vacuum. VF
= v/c. Wherein, v indicates the transmission speed in the medium; c indicates the light
speed.

The velocity factor is smaller than or equal to 1, which is related to the dielectric
constant (er) of the medium. It directly affects the transmission line electrical length
calculations, time delay compensation, and calibration accuracy.

Click the input field of Velocity Factor to set the velocity factor that applies to the
medium of the device that was inserted after the measurement calibration. The
velocity factor of the common transmission medium is as follows:

. Polyethylene dielectric cable: 0.66
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. PTFE dielectric: 0.7

+  Speed of light in a vacuum: 1.0

17.3 Constants

System Impedance

The actual impedance of the VNA hardware test port is generally 50 Q. The system
impedance can be changed for measuring device with an impedance other than 50 Q,
such as waveguide devices.

VNA mathematically transforms and displays the measurement data as though the
VNA ports were the specified impedance value. Physically, the test ports are always
about 50 Q.

Phase Offset

Click input field of Phase Offset to set the phase offset. By default, it is 0°.

«  Optimize the display effects of the phase measurement: The method is the
same as modifying the reference level in magnitude measurement. Adjust phase

response to make it in the middle of the screen or aligned.

«  Simulate the expected phase offset in the measurement: If a cable is
connected to the instrument and the cable length may cause some phase offset
for the measurement setup, then you can set the phase offset to correct the

offset.

Magnitude Offset

Click Magnitude Offset to offset the magnitude data of the current active trace by a
fixed value in dB in the vertical coordinate (Y-axis).

Magnitude Offset Slope

The magnitude offset slope shows that the magnitude offset varies with the
frequency. The offset slope begins at 0 Hz, in dB/GHz.

Click Magnitude Offset Slope to offset the data trace by a value that changes with
the frequency, making the current active trace to move in the vertical coordinate (Y-
axis) based on the set magnitude offset slope. On the screen, you can see the slope
varies with the frequency dynamically while the trace moves up and down, making it
vary linearly within the frequency range.
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18

18.1

Math Operation

The VNA supports saving the current data trace to the internal memory, and performs
math operation on the current data trace and memory trace. The data analysis
function includes the data transform of S-parameters, enabling statistics for the data
of the active trace, making statistics of the mean value, standard deviation, and peak-
to-peak values, and enabling the limit test.

Memory

Data->Memory

Click Data->Memory to save the measurement data of the active trace to the
memory. Click this menu for multiple times, and the latest data of the current active
trace will be saved to the memory. You can only store one memory trace data for
each trace.

Data Math

Before performing the data math operation, perform "Data->Memory" operation first
to ensure that there are available active trace data in the memory. Then perform the
specified type of math operation on the current measurement data of the active trace
and the trace data stored in the memory and then display them in the specified
format..

The math operation types supported include:

- Off: By default, it is disabled. No math operation is performed on the current
measurement data.

- Data / Memory: Current measurement data is divided by the trace data in the
memory. It is used for ratio comparison of two traces.

«  Data - Memory: Data in the memory is subtracted from the current

measurement data.

It can be used for storing a measured vector error, then subtract this error from
the DUT measurement to gain a more accurate result.

«  Data + Memory: Current measurement data is added to the data in the
memory. It can be used to add measurement results.
. Data * Memory: Current measurement data is multiplied by the data in the

memory. It can be used for some special analysis requirements.
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Normalize

The Normalize menu functions the same as performing "Data->Memory" first, and
then "Data / Memory". Current measurement data is divided by the trace data in the
memory. The normalized operation results will be shown on the current active trace,
and the data math will be automatically switched to "Data / Memory".

The Normalize operation aims to perform one reference measurement in the preset
condition and saves the measurement data to the memory as the reference data.
Then perform the actual measurement, compare the actual measurement data with
the reference data, and perform data math operation. The Normalize operation can
eliminate the error caused by the system, making the measurement results more
accurate.

Display

Sets the data display mode of the currently selected trace.

«  Data Trace: displays the current measurement data of all the created traces.

Memory Trace: displays the trace that was put in memory. If no memory data of
a certain trace is found, then the current measurement data of the trace will not
be displayed.

«  Data and Memory: displays both the current measurement data of the trace

and the trace that was put in memory.

18.2  Analysis

Parameter Conversion

The vector network analyzer supports parameter conversion function. You can
convert the measurement results of the S-parameter to the desired parameter mode.
After conversion, the trace curve will change. Engineers can better observe the
characteristics of the components.

Table 18.1 Conversion Type

Menulz::ynction Conversion Function Formula
Off Conversion disabled -
Impedance (Z,) in 1+5,,
Z-Reflect reflection Z, = Zy, % 1-S
measurement ~aa
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Menu Function

Conversion Function

Formula

Key
Impedance (Zy) in 2% fZo % Z
Z-Transmit transmission Z,= +Ub —(Zya * Zyp)-
measurement ab
1
Z-Trans-Shunt Impedance (Zy) Zy = —
transmission shunt Yz
Admittance (Y,) in |
Y-Reflect reflection Y, = E
measurement ¥
1 1
, , Yoo = —Yu = —
Admittance (Yy) in Za Zy,
Y-Transmit transmission
measurement 2 % "—}’hq + Yoy
}rt = - (Y—Du T }rﬂb
Sab
Admittance (Y;) in 2% /Y. * You
Y-Trans-Shunt transmission Y, = - — (You + Yo
measurement Sab
1
1/S Inverse S-Parameter -
Sab

Conjugation

Complex conjugate
number

Statistics

Check the checkbox of Statistics, and the checkbox is filled in green. The statistical

function for the current active trace is enabled. The statistics information is displayed
at the upper-right corner of the window, as shown in the figure below. Uncheck the

checkbox of Statistics, then the statistical function for the current active trace is
disabled. The statistics information will not be displayed at the upper-right corner of

the window.

Tr1 $11 LogM 10.00dB/ 0.00 dB
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-50

Start -10 dBmM — ——

0.00 dB

Peak to Peak:
Mean:

Std. Dev.:
Peak to Peak:
Mean:

Std: Dev.:

CW 1.00000 GHz

Stop 0dBm
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Click the input field of Statistics to set the statistics range for the current trace.

«  Full Span: By default, it is full span. That is the whole X-axis, which is the same as
the sweep range of the trace itself.

«  User 1 to User 16: makes statistics within the user-defined span. This settings
are the same as what you set for the Search Domain sub-menu under Search.

At most, 16 user-defined range can be set. You need to set Domain Start and
Domain Stop for each user-defined range. The user-defined ranges are
independent of each other and can overlap with each other.

The statistics information includes the following items:

. Peak to Peak: indicates the peak-to-peak value of the trace within the statistical
range.

. Mean: indicates the mean value of the trace within the statistical range.

«  Std. Dev.: indicates the standard deviation of the trace in the statistical range.

18.3 Limit Test

Limit test compares the measured data with the defined limit value to judge whether
the response data of the measurement meet the PASS/FAIL conditions to obtain the
test result.

To configure the limit test parameters, click Limit Test in the "Math" menu. The
measurement interface of the limit test is as shown in the figure below.

S11 LogM 10.00dB/ 0.00 dB

1
PASS

=Ch 1: Start 10.0000 MHz Stop 8.50000 GHz

Type Begin Stimulus End Stimulus Begin Response [End Response
MIN  » 2 GHz 4 GHz -10dB 5dB |
6 GHz 8 GHz . 0de
0Hz 0Hz 0 de

1. Limit Table

Used to define whether the response data of measurement complies with the pass
standards. Each line has a judge standard. By default, the limit table is disabled.
When enabled, the limit table displaying the current active trace is displayed below
the window.
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18.3.1

18.3.2

2. Limit Line

The judge standards defined for each line in the limit table includes begin stimulus
(X-axis) and end stimulus (X-axis); begin response (Y-axis) and end response (Y-
axis). They form a limit line on the screen. The limit line is a dotted line, and its
color is the same as the trace color. For each measurement trace, you can set
multiple discrete limit line to test the characteristics of the response of the test
component.

3. Test Result

When you enable the limit line, the result is displayed in the window. The data
points that fail are displayed in red.
TIP

The limit line and limit test are not applicable to Smith Chart or Polar Chart display format. If
the limit line and limit test are both enabled, when you select Smith or Polar format, the
system exits the limit test automatically.

To Enable or Disable the Limit Test

Enable/Disable

By default, the limit test is disabled. When enabled, the measurement data trace will
compare with the set limit line to display PASS or FAIL result.

Limit Line

By default, the limit line is disabled. When enabled, the limit line is displayed on the
screen. When you enable the limit test and disable the limit line, the limit test will still
continue.

Test Fail Sound

By default, sound on test failure is disabled. When enabled, the beep sounds when a
point on the data trace fails the limit test.

Limit Table

Configure the Limit Table

You can add and edit the limit line information in the limit table. Each line in the limit

table is a test rule for the limit line. To add a limit line, modify the "Type" parameter to
a value other than "OFF", then a new line will be added automatically in the table. The
"Type" parameter in the new line turns out to be "OFF".

e Click the drop-down button of Type to select OFF, MAX, or MIN.

- OFF: disables the limit line. That is, the limit line is invalid.
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- MAX: The MAX value will fail measurements above this limit.
- MIN: The MIN value will fail measurements below this limit.

. Begin Stimulus: a value for the signal source to begin outputting stimulus signal.
Click the input field under Begin Stimulus parameter to input the value.

. End Stimulus: a value for the signal source to stop outputting stimulus signal.
Click the input field under End Stimulus parameter to input the value.

. Begin Response: a value for the signal source to begin measuring DUT output
response. Click the input field under Begin Response parameter to input the
value.

. End Response: a value for the signal source to stop measuring DUT output

response. Click the input field under End Response parameter to input the value.

Load/Save Limit Table

Click Load Table, then the file management interface is displayed. Select the specified
limit table file suffixed with "*.csv", then click Confirm to load the specified file to the
limit table of the current active trace.

Click Save Table, then the file management interface is displayed. Select the path to
save the file, then click Save to save the limit table of the current active trace as a file
suffixed with "*.csv". If the file with the same filename already exists in the current
path, then overwrite the original file.

For details about the file management method, refer to
Example of Limit Table File (*.csv)

The limit table file suffixed with "*.csv" must contain the header in the following
format.

"# VNA Limit Test"
"# Revision: 1.00"
TYPE, BEGIN STIMULUS,END STIMULUS,BEGIN RESPONSE, END RESPONSE

1. The first line indicates the limit test type of the instrument.
2. The second line indicates the limit test version.

3. The third line indicates the title of the output parameters starting to output from

the fourth line.

4. The fourth line indicates outputting segment parameters and data.
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18.3.3 Global Pass/Fail

Enable or Disable Global Pass/Fail

The Global Pass/Fail feature enables or disables monitoring the status of all
measurements.

ON: when you enable Global Pass/Fail, the status of all the measurements is
displayed in the system status area. If any one of the traces fails in the limit line
test, the result shows "FAIL"; if no failed measurement exists, it displays "PASS".
OFF: when you disable Global Pass/Fail, the status of all the measurements is not

displayed in the system status area.

Global Pass/Fail Policy

Sets the policy to determine the global pass/fail status.

All Tests:

If all the limit tests pass, then the Global Pass/Fail status shows PASS.
All Measurements:
If all the measured data points fall within the established test limits and limit test

is ON, the Global Pass/Fail status will show PASS; if one measurement does not
have limit test ON, the Global Pass/Fail status will show FAIL.

This setting is more critical. If all the test pass, it shows PASS; otherwise, it shows
FAIL.

In this mode, if one measurement does not have Limit Test ON, the Global Pass/
Fail status will show FAIL.

18.4 DTF (Option)

The DTF (Distance To Fault) feature identifies fault location and distance by analyzing
reflected signals in the frequency domain. It calculates the distance from the fault
point to the reference plane based on reflection characteristics and frequency
response. Its working principle is as follows:

Signal reflection mechanism:

When electromagnetic waves encounter impedance discontinuities (such as
short circuit, open circuit, or loose connector) during transmission, a portion of
the energy is reflected back to the source. The amplitude and phase of the
reflected signal are related to the characteristics of the fault point (such as the
variation of impedance) and its location.

116

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.



Math Operation
EN

«  Conversion between time domain and frequency domain:

The VNA instrument measures the reflection coefficient (e.g., Si: parameter) in
the frequency domain, then transforms the frequency domain data into time
domain response through IFFT (Inverse Fast Fourier Transform). At this point, the
horizontal axis of the time domain waveform represents time, which can be
further converted to distance through the known velocity factor of signal
transmission in the medium.

. Distance calculation:

DTF (L) can be obtained with the following formula:L = (c*t*VF)/2. Wherein, c
indicates speed of light, t indicates round-trip of the reflection signal, and VF
indicates the velocity factor.

You can configure the following DTF-related parameters:
DTF State

By default, DTF state is disabled. Only when the sweep type is set to

for the current trace, can you enable the DTF function. Otherwise, the DTF function is
unavailable to use. DTF and TDA are mutually exclusive. When you enable either one
of them, the other will be disabled automatically.

When DTF is enabled, the window presents the relationship between the transmission
loss (Y-axis) and distance (X-axis). The measurement readout is displayed at the
upper-right corner of the window, and the marker marks the position of the displayed
marker. The unit of the X-axis can be selected from Distance Unit. By default, the unit
is Meter. The available units include Meter, Feet, and Inch.

$11 LogM 10.00dB/ 0.00 dB

8.818 pm -808.928 dB

=Ch 1: Start 0.00000 m

Stimulus Response

0.010 ym -B0.934 dB

Stop Distance

The stop distance defines the distance range within which the DTF function can
accurately measure fault points. The unit of stop distance is the one you select under
"Distance Unit".

The function of stop distance:

. Enables you to filter out the signal data in the irrelevant regions, and to focus on

measuring the target cable segment.
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«  The distance resolution of DTF (i.e., identifying the minimum fault interval) is
related to the frequency span and sweep points. The stop distance
determines the minimum number of sweep points required. Changing the stop
distance will make the system to automatically adjust the number of sweep

points.

Setting the stop distance can avoid long measurement time arising from too
many sweep points; or low DTF resolution arising from insufficient sweep points.

. DTF can realize the conversion between the time domain and distance based on
the IFFT of frequency data, and has a physical limitation of "unambiguous
distance”. If the configured stop distance exceeds the unambiguous distance,
reflection signals originating from different fault locations will superimpose in

the time domain, resulting in measurement failure.

Cable Loss

During cable transmission, electromagnetic waves will result in attenuation due to
loss. Therefore, the longer the distance, the smaller the signal amplitude. If the
reflection signal of the distance faults is too weak, it may cause misjudge of fault.
Therefore, you need to compensate the signal attenuation caused by cable
transmission.

Cable loss is the attenuation characteristics parameters of the signal in the cable
transmission, expressed in dB/m. Configuring the cable loss can compensate the
attenuation of stimulus signal in different positions of the cable, making the peak
amplitude of the reflection signal at fault points of different distances in the
transmission cable more precise, ensuring that the fault points can be identified
accurately.

Velocity Factor

Velocity factor is the ratio of the transmission velocity of the signal in a medium to
the speed of light in vacuum. For details, refer to

Through the velocity factor and the X-axis coordinate (time) where the specified
measurement marker is located, you can obtain the distance (length) between the
test port and the fault point.

Window Function

The available window types are Rectangular, Hanning Hamming, Gaussian, and
Flattop. You can select a proper filter type by referring to the following table
according to the actual measurement requirements.
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Window Function ad | G | R
Gaussian Moderate Good Medium
Flattop Good Excellent Poor
Rectangular Poor Poor Excellent
Hanning Good Medium Good
Hamming Good Medium Good

18.5 Time Domain (TDA Option)

The VNA instrument is usually used to analyze the characteristics of the frequency
domain of the device, but also can use the frequency domain parameters to calculate
the inverse Fourier transform (IFFT) to obtain the characteristics of time-domain of

the device.

TDA (Time Domain Analysis) feature enables the measured frequency domain data to
convert to the time domain data through math calculation, and makes an analysis for
the time domain characteristics of the DUT.

The basic principle of the TDA feature is: Send a signal on the transmission cable, and
if mismatch impedance (such as Open Circuit, Short Circuit, and impedance variation)
occurs during transmission, some signals will be reflected. Through measuring the
delay between the transmission pulse and reflection pulse, in combination with the
transmission rate of the signal on the transmission cable, you can determine the
impedance distribution and fault location on the transmission cable.

S11 LogM 10.00dB/ 0.00 ¢B
50
40
30
20
10
0
-10
20
-30
-40
-50

1 >Ch 1: Start -18.0000 ns

e Stop 22.0000 ns

. Transform State:

By default, it is disabled. When it is enabled, the coordinate in the window
switches to the time-domain mode. The measurement trace is displayed in the
window, with the X-axis coordinate representing time.

. Start Time:

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved.

119



Math Operation

EN

Sets the transform start time that is displayed on the analyzer screen, as @
indicated in the above figure.

. Stop Time:
Sets the transform stop time that is displayed on the analyzer screen, as @
indicated in the above figure.

. Center Time:

Sets the transform center time that is displayed in the center of the analyzer
screen, as 3 (a T icon) in the above figure.

. Span Time:
Sets the transform span time that is split on either side of the center value. It is

the difference between the transform stop time and transform start time in the
window.

The start time, stop time, center time, and span time are mutually affected with each
other. Changing the start time or stop time will also change the values of center time
and span time. The start time and stop time will also be changed when modify the
center time or span time.

Transform Type

Three transform types are available. They are three variations on how the time
domain transform algorithm is applied to the frequency domain measurement.

«  Band Pass: applicable to scenarios where resolution requirement is not high and

requires rapidly locating problems in the wideband.

It features wide pulse and low resolution, applicable for measuring band limited
devices.

+  Low Pass Impulse

Narrow pulse, high resolution, easy to identify the tiny impedance variations in
devices that pass low frequencies.

. Low Pass Step:

Step signal, sensitive rising edge, easy to identify inductive and capacitive
discontinuities in devices that pass low frequencies.

NOTE

If you choose Low Pass Impulse or Low Pass Step, note that the start frequency shall be equal
to the step frequency.
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18.6  Time Gating (TDA Option)

The time domain gating feature converts the raw measurement data from the
frequency domain to the time domain. In the time domain, data are filtered according
to filtering conditions. The filtered data are then subjected to Fourier transform to
convert it back into the corresponding frequency domain characteristic curve for
further analysis. Time domain gating is a commonly used method to filter the
frequency domain signal.

>Ch 1; Start -17.0000 ns Stop 23.0000 ns

You can set the following parameters:
+  Gating State:

By default, gating is disabled. When enabled, the measurement data will be
filtered according to the set time gating condition. Before enabling the gating,
first enable to convert the current measurement
trace to be displayed in the time domain coordinate system.

. Start Time:
Sets the start time for the gate. It is indicated as @ (a flag icon) in the above
figure.

. Stop Time:
Sets the stop time for the gate. It is indicated as @ (a flag icon) in the above
figure.

. Center Time:
Sets the center time for the gate. It is indicated as 3 (a T icon) in the above
figure.

+  Span Time:
Sets the range to either side of the center value of the area that is affected by

the gating function. It is the difference between the stop gate time and start
gate time in the window.
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The start time, stop time, center time, and span time are mutually affected with each
other. Changing the start time or stop time will also change the values of center time

and span time. The start time and stop time will also be changed when modify the
center time or span time.

Gate Type

Defines the type of filtering that will be performed for the gating function.
. Band Pass: keeps the response data within the gate span.

. Notch: removes the response data within the gate span.

Gate Shape

Defines the filter characteristics of the gate function. The available gate shapes
include Maximum, Wide, Normal, and Minimum. The definitions are as follows:

Gate Shape

Passband Ripple

Gate Marker -6 dB ——»

Side Lobe Level

d 1
Gate Start Gate Stop
gl:;?oe E?;;'I:’:"d Eg‘:‘fbe Cut-off Time Minimum Gate Span
Min. +0.1 dB -48 dB 1.4/Frequency Span 2.8/Frequency Span
Normal +0.1 dB -68 dB 2.8/Frequency Span 5.6/Frequency Span
Width +0.1 dB -57 dB 4.4/Frequency Span 8.8/Frequency Span
Max. +0.01dB |-48 dB 12.7/Frequency Span | 25.4/Frequency Span

Cut-off Time indicates the time between the stop time (-6 dB on the filter skirt) and
the peak of the first sidelobe. The diagram above shows the overall gate shape and
lists the characteristics for each gate shape.

e T1is the gate span, which is equal to the stop time minus the start time.

e T2is the time between the edge of the passband and the 6 dB point,

representing the cut-off rate of the filter.

+  T3is the time between the 6 dB point and the edge of the gate stopband.
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. For all the filter shapes, T2 is equal to T3, and the filter is the same on both sides

of the center time.

Minimum gate span is twice the cut-off time. Each gate shape has a minimum
recommended gate span for proper operation. This is a consequence of the finite
cutoff rate of the gate. If you specify a gate span that is smaller that the minimum
span, the response will show the following effects:

. Distorted gate sharp that has no passband
. Distorted shape
. Incorrect indications of start and stop time

. May result in increased sidelobe level

18.7 Time Domain Setup (TDA Option)

Channel Coupling

Enables or disables the coupling state for the specified parameters of all the traces for
the same channel.

«  Coupling State:

- ON: By default, it is enabled. When it is enabled, modifications of the
specified parameters for the current active trace are global to all the traces
of the current channel.

- OFF: When it is disabled, modifications of the parameters for the current
active trace will not affect the other traces of the current channel.

«  Transform Parameters: selects the time domain transform related parameters
that support channel coupling.

non non

Stimulus: the "Start Time", "Stop Time", "Center Time", and "Span Time"

settings in the Time Domain menu.
- State (On/Off): the "Transform State" setting in the Time Domain menu.

- Window: the "Kaiser Beta" and "Impulse Width" settings in the Time

Domain Setup menu.
- Mode: the "Transform Type" setting in the Time Domain menu.

- Distance Marker Unit: the "Units" setting in the Time Domain Setup menu.

Copyright ©RIGOL TECHNOLOGIES CO., LTD. All rights reserved. 123



Math Operation

EN

«  Gating Parameters: selects the time domain gating related parameters that
support channel coupling.
- Stimulus: the "Start Time", "Stop Time", "Center Time", and "Span Time"
settings in the Time Gating menu.
- State (On/Off): the "Gating State" setting in the Time Gating menu.
- Shape: the "Gate Shape" setting in the Time Gating menu.

- Type: the "Gate Type" setting in the Time Gating menu.

Marker Mode

In the Time Domain menu, click ON under Transform State to enable the time
domain transform. Then in the marker measurement result of the current active trace,
transmission cable length (Dist.) of the specified marker in the coordinate is added.

+  Auto: selects the marker mode automatically according to the S-parameter of
the current trace. For example, S12 is the transmission mode; S11 is the
reflection mode.

. Reflection: sets the current trace measurement to reflection parameter.

e Transmission: set the current trace measurement to transmission parameter.
Under the same measurement condition, if transmission mode is selected, the
obtained transmission cable length is twice the length in the reflection mode.

$11 LogM 10.00dB/ 0.00 dB

= 1.808 ns 32.842 dB
40 Dist.(Refl) 99.808 mm
an >2:  600.800 ps 2.271 dB

Dist.(Ref1) 59.480 mm

i

1 >Ch1: Start -10.0000 ns

Distance Transfer

Configures the relevant parameters of the signal in converting the cable transmission
time into cable length.

e Units: Specifies the unit of the distance (length) measured from test port to

destination point. The available units are Meters (default), Feet, and Inches.
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«  Velocity Factor:

Indicates the ratio of the transmission velocity of the signal in a medium to the
speed of light in vacuum. For details, refer to

Through the velocity factor and the X-axis coordinate (time) where the specified
measurement marker is located, you can obtain the distance (length) between
the test port and the destination point.

Window Function

In the TDA test, you can modify Kaiser Beta and Impulse Width. Beta parameter is
inversely proportional to impulse width, and they are mutually affected with each
other.

«  The greater the Beta value, the narrower the impulse width and the higher the
time resolution, applicable for detecting multiple impedance discontinuities at
close range, but sidelobe suppression is relatively weak.

e The smaller the Beta value, the wider the impulse width and the stronger the
sidelobe suppression, applicable for detecting weak reflection or long distance

fault, but the time resolution is relatively low.

18.8 Skew Measure (TDA Option)

In high-speed differential systems, the time difference or length difference between
two identical source signals in the transmission path is called signal skewing.

The skew test is based on Time Domain Reflectometry (TDR) technology and
accurately quantifies the skew value by transmitting a low-pass step signal to the
DUT, comparing the step response time of the reference trace with the measured
trace, which can be used for the relative deviation calibration of differential signals.

To use the skew test feature, you need to install the TDA option first.

To configure the skew test parameters, click Skew Measure in the "Math" menu.
+  Skew State
By default, it is disabled. When it is enabled,
- Click Time Domain > Transform State to enable the transform state.
- Click Time Domain > Transform Type to select "Low Pass Step".

- Set the trace data format for the skew test to Real.
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18.9

- Start the skew test for the current trace. The skew test result for the trace is
displayed at the top part of the window.
Measure Threshold

It is used to set the measurement point for step voltage. By default, it is 50%. It
means measurements are taken at 50% of step voltage by default. Its range is
from 10% to 90%. It will automatically adjusted to its boundary value when the
value you set is out of its range.

Skew Limit

By default, it is O s. Its range is from -1.0e+15 s to 1.0e+15 s.

If the absolute value of the time skew exceeds the limit value, the test fails,
displaying "Fail" following the test result; otherwise it shows "Pass".

Reference Trace
The reference trace is used to compare with the current trace, which must be in

the same channel as the current trace. To select the reference trace, you need to
enable the skew state.

Delay Measure (TDA Option)

Signal delay refers to the total time for a single signal to transmit from the transmitter
to the receiver. It directly reflects the length of the transmission path, media
characteristics, or delay characteristics of the component. Delay testing is based on
the low-pass step mode of Time Domain Reflectometry (TDR). By measuring the time
difference between the stimulus of a step signal and the corresponding response of
the Device Under Test (DUT), it enables absolute delay measurement without
requiring a reference trace. This method is particularly suitable for characterizing
single-path transmission characteristics.

To use the delay test feature, you need to install the TDA option first.

To configure the delay test parameters, click Delay Measure in the "Math" menu.

1.

Delay State

By default, it is disabled. When it is enabled,

Click Time Domain > Transform State to enable the transform state.

Click Time Domain > Transform Type to select "Low Pass Step".

Set the trace data format for the delay test to Real.

Start the delay test for the current trace. The delay test result for the trace is

displayed at the top part of the window.
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2. Measure Threshold

It is used to set the measurement point for step voltage. By default, it is 50%. It
means measurements are taken at 50% of step voltage by default. Its range is from
10% to 90%. It will automatically adjusted to its boundary value when the value
you set is out of its range.
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19

19.1

19.2

19.3

Setup

This menu allows you to perform quick operation for some functions, save, recall, and
manage files.

Layout

In the Layout menu, you can quickly add, delete, and select the trace, channel,
window, and sheet. For detailed information about the trace, channel, window, and
sheet, refer to descriptions in "Trace” and "Channel".

. Click Add Trace, Add Channel, Add Window, or Add Sheet to quickly add a
trace, a channel, a window, or a sheet. They are set to be activated.

e Click Delete, and the sub-menu shows the existing sheet, window, channel, and
trace. If a green dot exists at the left side of the specified item, it indicates that
the item is activated. Click any of the items (trace, channel, window, or sheet)
from the drop-down list of Delete to delete the desired one.

«  Click Select, and the sub-menu shows the existing sheet, window, channel, and
trace. If a green dot exists at the left side of the specified item, it indicates that
the item is activated. Click any of the items (trace, channel, window, or sheet)
from the drop-down list of Select to select the desired one to be activated. Once

selected, a green dot will be highlighted at the left part of the selected item.

Sweep Setup

The sweep setup menu has the same function as the Main sub-menu of Sweep. For
detailed operations, refer to in "Sweep".

S-Parameter

The sub-menus of the S-Param in the S-Parameter menu are the same as that in
Measure >S-Param. For detailed descriptions, refer to in the "Measure"
menu.
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19.4  Display Setup

Window Max

By default, Window Max is disabled. When you have created multiple windows,
multiple windows are displayed on the screen simultaneously. When Window Max is
enabled, the currently selected window will be maximized, and the "Window Max"
label is displayed at the upper-right corner of the window.

In multi-pane windowing state, you can double-click the specified window to
maximize the selected window; double-click it again to exit the "Window Max" state.

Grid Line
Sets the grid line in the window to "Solid" or "Dotted". By default, it is Solid.

Show Table

. None: default setting. The table is not displayed below the window.
. Marker: a marker table is displayed below the window.
. Limit: a limit test table is displayed below the window.

«  Segment: a segment sweep table is displayed below the window.

Layout Mode

In multi-pane windowing, you can select the layout mode.

e Auto: default layout mode. The window size can be adjusted automatically based
on the number of windows. Different windows can be different in size. The
windows cover the whole window display area.

. Fixed: Adjusts the size of the window automatically based on the number of

windows. Each window size is the same.

Max Window Count

By default, up to 9 windows are supported to be displayed in the window display
area. The available max. window count can be set to 1, 2, 4, 6, and 9. When the
number of created windows exceeds the max. number of windows that can be
displayed in the window display area, click Pg Up or Pg Dn to page up or page down
the display interface to find the specified window.
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19.5 Save

The Save operation is performed in the file management interface, as shown in the
figure below.

File Management

(8 i Local Disk ¥ |

New Folder Re D

- 0808 1970-01-02 21:54:37 D
- 0915 1970-01-03 11:54:06 [ ]
B 15m~26_5¢ 19700101 08:41:40 ()
B 1k-~500k 1970-01-01 08:41:31 ]
B 510k~10m 1970-01-01 08:41:49 ]
- loghelper 1970-01-01 08:20:38 |:|
L5 logs 1970-01-0311:39:26 ]
s yi2-10hz-VNA 1970-01-01 08:12:06 ]
- ==
| NewFile1

For the file management operation, refer to ///~. The procedures for saving the file are

as follows:

«  Set the filename: click the input field of the filename, then the virtual keypad is
displayed. Input the filename with the virtual keypad.

«  Select the file format: click the drop-down button of the file format to select
the desired format.

«  Save: click Save to save the file with the specified filename and format to the

current selected path.

Save State

Click Save State, then the file management interface is displayed. Save the current
state information of the instrument to the specified path with the filename suffixed
with ".sta".

Save CalSet

Click Save CalSet, then the file management interface is displayed. Save the current
calibration sets information of the instrument to the specified path with the filename
suffixed with ".cal".
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State+CalSet

Click State+CalSet, then the file management interface is displayed. Save the current
state and calibration sets information of the instrument to the specified path with the
filename suffixed with ".csa".

Save SNP

The *.snp file format is also known as Touchstone format. The "*.snp" data are usually
used to gather all S-parameters for a fully corrected measurement. The file in
Touchstone format is suffixed with "*.snp". Wherein, n indicates the number of ports.
For example, "*.s2p" indicates a 2-port network; "*.s4p" indicates a 4-port network.
The "*.snp" file contains the header information, stimulus data, and a response data
pair for each S-parameter measurement. The file is a text file, and can be opened with
the notebook.

Click Save SNP, then the "Save SNP" interface is displayed.

Save SNP

— Pots ——————————  — Format

@ Port1 [ Port2 ® Auto

Real/Imaginary
LinMag/Angle

LogMag/Angle

Cancel

Select the specified port and format of the data to be saved, then click Next. The file
management interface is displayed. Save the current S-parameter information of the
instrument to the specified path, with the filename "*.s1p" (single port data of Port1
or Port 2) or "*.s2p" (Dual-port data of both Port1 and Port2).

Save CSV

Click Save CSV, then the "Save CSV" interface is displayed. Select the specified scope
and format of the data to be saved, then click Next. The file management interface is
displayed. Save the current S-parameter information of the instrument to the
specified path with the filename suffixed with "*.csv".

Screenshot

In the screenshot interface, configure the settings for Color, Invert, Header, Overlay,
File Name, Format and File Path. Click Screenshot button to complete the screenshot
capture.
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19.6

Screenshot

Color & Invert

Header m Overlay

File Name RigolVNA Format
File Path B

Default Option = Secreenshot

Recall

The Recall operation is performed in the file management interface, as shown in the
figure below.

File Management

¢ |Local Disk v |

New Folder

0808 1970-01-02 21:54:37
0915 1970-01-03 11:54:06
15m~26_5g 1970-01-01 08:41:40
1k~500k 1970-01-01 08:41:31
510k~10m 1970-01-01 08:41:49
loghelper 1970-01-01 08:20:38
logs 1970-01-03 11:39:25

y|2-10hz-VNA 1970-01-01 08:12:06

1000000000

LI

For the file management operation, refer to
Recall State

Click Recall State, then the file management interface is displayed. Select the
specified "*.sta" file from the specified path, click Confirm to complete the recalling
operation.

State+CalSet

Click State+CalSet, then the file management interface is displayed. Select the
specified "*.csa" file from the specified path, click Confirm to complete the recalling
operation.

Recall CalSet

Click Recall CalSet, then the file management interface is displayed. Select the
specified "*.cal" file from the specified path, click Confirm to complete the recalling
operation.
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Recall SNP

Click Recall SNP, then the file management interface is displayed. Select the specified
"*.snp" file from the specified path, click Confirm to complete the recalling operation.

19.7 File

File Management

Click Manage Files, then the file management interface is displayed.

File Management

& |Local Disk v |

New Folder =~ Rename Delete O
- 0808 1970-01-02 21:54:37 D
B oos 1970-01-03 11:54:06 [ ]
. 15m~26_5¢g 1970-01-01 08:41:40 [:]
B 1k~500k 1970-01-01 08:41:31 ]
- 510k~10m 1970-01-01 08:41:49 D
. loghelper 1970-01-01 08:20:38 D
- logs 1970-01-03 11:39:25 D

=4 yi2-10hz-VNA 1970-01-01 08:12:06 D

LI

You can perform the following operations in the file management interface.
«  Select the Disk

Before using the external storage device, please ensure that the USB storage
device (FAT32 format, flash memory) is properly connected. By default, contents
in the "Local Disk" are displayed in the file management interface. If an external
storage device is inserted, "Removable USB Disk" is added to the available disks.
Select "Removable USB Disk", then the contents of the USB Disk(D) is displayed
in the file management interface.

. Create a Folder

Click New Folder, then the virtual keypad is displayed, input the folder name to
create a new folder.

. Enter or Exit the Folder

Double-click the specified folder to open the folder. The contents in the folder
are displayed. The current path can be seen in the disk selection area. Click <- to
exit the current folder and go back to the previous level of folder.

. Select a File or Folder
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Before operating on a file or folder, first select the file or folder. Check the
checkbox of the specified file or folder to select it. You can select multiple files or
folders.

. Rename a File or Folder

Select the specified file or folder, click Rename, then the virtual keypad is
displayed. Input the filename or folder name. Click OK to complete the input.

. Delete a File or Folder

Select a file or folder to be deleted. Click Delete, then a prompt message that
prompts you to confirm whether to delete the file or folder is displayed. Click
Confirm to confirm deleting it. Click Cancel to cancel deleting operation.

«  Copy, Cut, and Paste a File or Folder: Select a file or folder, then click the

specified button such as cut, copy, or paste to perform the specified operation.

Safe Clear

Click Safe Clear, then a prompt message "Are you sure to execute secure memory
wipe?" is displayed . Click Confirm to clear the internal memory safely. Click Cancel to
cancel safe clear operation.

Upgrade

This instrument supports local upgrade.
1. Save the upgrade file suffixed with "*.GEL" to the specified path of the instrument.
2. Click Upgrade, then the file management interface is displayed.

3. Select the upgrade file from the destination path. Then click Confirm to start local
upgradse.
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20 Save & Recall

This menu allows you to perform quick operation for saving, recalling, and managing

files.
Save

The saving operation is the same as what described in Save menu under Setup. For
details, refer to

Recall

The recalling operation is the same as what described in Recall menu under Setup.
For details, refer to

File

The file management operation is the same as what described in File menu under
Setup. For details, refer to
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21 System

In the System menu, you can set the system-related parameters, 1/0O settings, etc. To
enter the System menu, perform the following operation.

«  Click the notification area at the lower-right corner of the screen to enter the
System menu.

System

. Press to enter the System menu.

21.1 I/0 Setting

In the System menu, click 10 to enter the I/O interface settings. You can configure the
following parameters.

Network Status

Different prompts will be displayed according to the current network connection
status.

«  Network Config Succeeded!
e Acquiring IP..

e IP Conflict!

«  DISCONNECTED!

«  DHCP Config Failed

¢ Read Status Fail!

«  CONNECTED

. Invalid IP

. IP lost

e Please wait...

MAC Address

The MAC address of each oscilloscope is unique. When assigning the IP address for
the oscilloscope, the system uses the MAC address to identify the instrument.

VISA Address

Displays the VISA address currently used by the the instrument.
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IP Configuration Type

The configuration type of the IP address can be DHCP, Auto IP, or Static IP. In different
IP configuration types, the configurations for IP address and other network
parameters are different.

DHCP

If "DHCP" is selected, the DHCP server in the current network will assign the
network parameters (e.g. IP address, Subnet, Gateway, and DNS) for the the
instrument.

Auto IP

When "Auto IP" is selected, the instrument will acquire the IP address ranging
from "169.254.0.1" to "169.254.255.254" and the subnet mask (255.255.0.0)
automatically based on the current network configuration. The "Auto IP" works
only when "DHCP" is not selected or connection is failed.

Static IP

If "Static IP" is selected, the instrument is configured with static IP. In this case,
you need to disable DHCP and Auto IP manually. At this time, you need to set
the IP address, Subnet, Gateway, and DNS manually. At this time, you can self-
define the network parameters (e.g. IP address) of the instrument.

Set the IP address

The format of the IP address is nnn.nnn.nnn.nnn. The range of the first
segment (nnn) of the address is from 0 to 255 (except 127); wherein, the
valid range is from 0 to 223. The range for the other three segments is from
0 to 255. You are recommended to ask your network administrator for an IP
address available.

Set the subnet mask

The format of the subnet mask is nnn.nnn.nnn.nnn. Wherein, the range of
"nnn" is from 0 to 255. You are recommended to ask your network
administrator for a subnet mask available.

Set the default gateway

You can set this parameter in Static IP mode. The format of the gateway is
nnn.nnn.nnn.nnn. The range of the first segment (nnn) is from 0 to 223
(except 127), and the range for the other three segments is from 0 to 255.
You are recommended to ask your network administrator for a gate address
available.

Set the DNS address

You can set this parameter in Static IP mode. The format of the DNS address
is "nnn.nnn.nnn.nnn". The range for the first segment (nnn) of the address is
from 0 to 223 (except 127); and the range for the other three segments is
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from 0 to 255. You are recommended to ask your network administrator for
an address available.

Generally, you do not need to set the DNS, therefore this parameter setting

can be ignored.

TIP
. When the three IP configuration types are all turned on, the priority of the parameter
configuration from high to low is "DHCP", "Auto IP", and "Static IP".

. The three IP configuration types cannot be all turned off at the same time.

mDNS

Click on the ON/OFF tab for mDNS to enable or disable the multicast Domain Name
System (mDNS). This system is used to provide the function of DNS server for service
discovery in a small network without a DNS server.

Host Name
The length of the host name is a string of 26 characters at most.
GPIB

When controlling the instrument via the GPIB, first use the USB-GPIB module to
extend a GPIB interface, then use the GPIB cable to connect it to the PC. Configure
the GPIB address. Its settable range is from 1 to 30. By default, it is 1.

Apply the Network Parameter Setting

Click Apply to validate the current network parameter setting. Click Reset to restore
to the default settings.

The interface settings are saved to the non-volatile memory. Each time the instrument
is restarted, it will load the last interface settings automatically.

Basic Settings

In the System menu, click Setting to enter the basic setting menu.
Language

This product supports menus in multiple languages. The help information, prompt
messages, and interface can be displayed in multiple languages. Click the drop-down
button of Language to select the specified system language from the drop-down list.

Power Switch
«  OFF: After the oscilloscope is connected to power, you need to press the Power
key on the front panel to power on the instrument.

»  ON: After the the oscilloscope is connected to power, it will be powered on
automatically.
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Beeper

Click the ON/OFF tab for Beeper to enable or disable the beeper. When the beeper is
enabled, you can hear the sound of the beeper when you perform the following
operations:

e Operate on the touch screen

«  When a prompt message is displayed

Screen Brightness
Drag the slide to set the screen brightness. Its range is from 0% to 100%.
Show Time

Click the ON/OFF tab for the Show Time menu to enable or disable the display of the
system time. When enabled, the system time (date and time) is displayed in the
Notification Area at the lower-right corner of the screen. The date is displayed in
"yyyy/mm/dd" format, and the time is displayed in "hh:mm:ss" format. You can enable
or disable the display of system time when saving the waveform. When enabled, the
saved file will contain the system time information.

« Date: Click the "Date" area, then the date setting interface is displayed. Drag the
year, month, and day section up and down respectively to set the date. Click

Confirm to confirm the date modification. Click the close window icon to
cancel the date modification and exit the menu. You can also click any place
other than the date setting interface to exit the date modification menu.

«  Time: Click the "Time" area, then the time setting interface is displayed. Drag the

hour and minute section up and down respectively to set the time. Click Confirm

to confirm the time modification. Click the close window icon to cancel the
time modification and exit the menu. You can also click any place other than the
time setting interface to exit the time modification.

About this Instrument

In the System menu, click About to view the model of the instrument, its serial
number, firmware version, etc.

*  Model: indicates the product model.

. Serial number: indicates the serial number of the instrument. It is the unique
identity of the instrument.

. Firmware: indicates the firmware version of the instrument.

. Hardware: indicates the hardware version of the instrument.
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¢ Build: indicates the build time of the software version of the instrument.
*  Android. Build: indicates the build time of the Android operating system.

«  Android.Version: indicates the version number of the Android operating system.
For example, 7.1. 0.

»  Launcher: indicates the GUI version number of the Android operating system.

«  WebControl: indicates the version number of the web control module.
Upgrade

This instrument supports local upgrade.

1. Save the upgrade file suffixed with "*.GEL" to the specified path of the instrument.

2. In the System menu, click About > Upgrade, then the file management interface
is displayed.

3. Select the upgrade file from the destination path. Then click Confirm to start local
upgradse.

21.4  Options

In the System menu, click Options to view all the options. For the procedures of
installing the option, refer to descriptions in
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22 Remote Control

This instrument supports Web Control remote operation. Web Control is Web-based
remote control operation. With Web control, you can access and operate the LAN-
connected instrument via the web page on any smart terminals such as PC, mobile,
and iPad, without needing to install any software. The operation procedures are as
follows:

1. Connect the instrument to the network

Ensure that the rear-panel LAN interface is connected to the network. Note that
the instrument must be connected to the network where the control terminal is
located. Then you can operate the instrument in remote way by accessing the
network.

2. Obtain the IP address
In the System menu, click 10 to view the IP address of the instrument.

3. Input the IP address of the instrument into the browser address bar, then press
Enter to access the web page, as shown in the following figure.
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RIGOL RIGOL Web Control

Welcome
Welcome

Web Control

Print Screen

Instrument Model:

MNetwork Status

Manufacturer:

Network Settings Serial Number:

SCPI Panel Control i
LXI Extended Functions:

Security )
LXI Version:
RIGOL Web mMDNS Host Name:

MAC Address:

IP Address:

Firmware Revision:

VISA TCP/IP String:
Auto-MDIX Capable:
VISA USB Connect String:
SCPI Socket Port:

Current Time:

. Click Web Control on the left side of the screen to enter the instrument remote

control interface. You can use the mouse to remotely control the instrument in real
time, with the same effect as operating the instrument directly.

. Click Print Screen, and you can select "Take Screenshot" or "Record Screen" to

capture the current screen shot.

. Click Network Settings to configure the network. Note that login is required when

changing the network configuration. When you first log in to the Web Control, use
the user name "admin" and the password "rigol"..

. The SCPI Panel Control function allows the user to send SCPI commands through

the web interface for remote programming control of the instrument. Click SCPI
Panel Control to enter the commands into the SCPI Command input field. After
inputting the commands, click the Send&Read button to send the command and
read the returned value.

You can program and control the instrument by using the SCPI (Standard
Commands for Programmable Instruments) commands.For details about the SCPI
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commands and programming, refer to Programming Guide of this series of
product.

8. Close the browser to exit the instrument remote control interface.

Only one user can access the instrument IP address for remote control operation at a
time. First come, first served. Concurrent logins are not allowed. If the connection is
interrupted, you can refresh the browser to load the page.

CAUTION

Before setting up communication, please turn off the instrument to avoid causing

damage to the communication interfaces.
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Preset

Press on the front panel to recall the preset settings and restores the system

settings of the analyzer to factory defaults.

Parameter Name

Parameter Value

Trace

Selected Trace Trace 1
Trace Title Off

Trace Hold Off
Channel

Selected Channel Channel 1
Selected Window Window 1
Window Title Off
Selected Sheet Sheet 1
Sheet Title Sheet 1
Frequency

Start Freq 10 MHz
Stop Freq Related to the instrument model

Center Freq

Related to the instrument model

Span Related to the instrument model
Sweep

Sweep Points 201

Sweep Type Linear Frequency

Delay Time Os

Auto Sweep State Auto

Auto Dwell Time 0s

Measure

S-Parameter S11

Parameter Conversion Off

Data Format

Log Magnitude

Marker

Selected Marker Marker 1
Delta Marker Off
Discrete Off
Marker Table Off
Marker Type Normal
Show Marker Readout On
Readouts Per Trace 5
Symbol Triangle

Coupling Mode

Channel Coupled

Search
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Parameter Name

Parameter Value

Search Domain Full Span
Search Tracking Off
Peak

Peak Threshold -100 dB
Peak Excursion 3dB
Peak Polarity Positive
Target

Target Value 0dB
Target Transition Both
Multi Peak & Target

Multi Peak Threshold -100 dB
Multi Peak Excursion 3dB
Multi Peak Polarity Positive
Multi Target Value 0 dBm
Multi Target Transition Both
Power

State On
Signal Output Port Port1
Port Power -5dBm
Avg BW

IF BW 100 kHz
Averaging

Averaging Enable Off

Avg Number 1
Average Type Sweep
Smoothing

Smoothing Enable Off
Smoothing Aperture 1%
Smoothing Points 3
Group Delay Aperture

Percent of Span 5%
Number of Points 11
Frequency 424.5 MHz
Trigger

Trigger Mode Continuous
Trigger Source Internal
Trigger Scope Channel
Input

Global Trigger Delay Os
Trigger Level/Edge High Level
Output
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Parameter Name

Parameter Value

Enable Off
Polarity Negative pulse
Position After Acquisition
Per Point Off

Pulse Duration 1 us
Scale

Scale 10 dB
Reference Level 0dB
Reference Position 5
Electrical Delay

Electrical Delay Time Os
Electrical Delay Distance Om
Distance Unit Meter
Velocity Factor 0.66
Constant

System Impedance 50Q
Phase Offset 0°
Magnitude Offset 0dB
Magnitude Offset Slope 0 dB/GHz
Math Operation

Data Math Off
Display Data Trace
Parameter Conversion Off
Statistics Off

Limit Test

Enable Off

Limit Line Off

Limit Table Off
Global Pass/Fail Off
Global Pass/Fail Policy All Tests
DTF

DTF State Off
Distance Unit Meter
Stop Distance 0

Cable Loss 6.72 m
Velocity Factor 0.66

Window Function

Rectangular

Time Domain

Transform State Off
Start Time -10 ns
Stop Time 10 ns
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Parameter Name Parameter Value
Center Time Os

Span Time 20 ns
Transform Type Band Pass
Time Gating

Gating State Off

Start Time -10 ns
Stop Time 10 ns
Center Time Os

Span Time 20 ns
Gate Type Band Pass
Gate Shape Normal
Time Domain Setup

Coupling State On
Marker Mode Auto

Unit Meter
Velocity Factor 0.66
Kaiser Beta 6.00
Impulse Width 227.701 ps
Calibration

Correction Off
Interpolation Off

Port Extension

Enable Off

Delay Os
Distance Om
Distance Unit Meter
Velocity Factor 0.66
Fixture

Apply Fixture Off

Port Match Off

Port Z Off
2-port DeEmbed Off
Save/Recall

Path | C:/data/UserData
System

Language | English
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Troubleshooting

1. When | power on the instrument, the instrument stays black and does not
display anything.

a. Check whether the power is correctly connected.

b. Check the power key on the front panel, and ensure that LED light of at least
one test connector is illuminated in green. This proves that the power key is
enabled and works normally.

c. Check whether the fuse is blown. If you need to replace the fuse, use only the
specified fuse that conforms to the product.

d. Restart the instrument after finishing the above inspections.
e. If the problem still persists, contact RIGOL.
2. The USB storage device cannot be recognized.

a. Check whether the USB storage device can work normally when connected to
other instruments or PC.

b. Make sure that the USB storage device is FAT32 format and flash type. The
instrument doesn't support hardware USB storage device.

c. After restarting the instrument, insert the USB storage device again to check
whether it can work normally.

d. If the problem still persists, contact RIGOL.
3. The touch functions cannot be used normally.

a. Check whether you have locked the touch screen. If yes, unlock the touch
screen.

b. Check whether the screen or your finger is stained with oil or sweat. If yes,
please clean the screen or dry your hands.

c. Check whether there is a strong magnetic field around the instrument. If the
instrument is close to the strong magnetic field (e.g. a magnet), please move
the instrument away from the magnet field.

d. If the problem still persists, contact RIGOL.
4. The user interface has not refreshed for a long time.
a. Check whether the screen is locked or not. If yes, press Esc to unlock it.

b. Check whether all the trigger conditions have been met and whether there is a

valid trigger signal.
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c. Check whether the analyzer is in Stop state or in single trigger state.
5. The performance specifications test is failed.
a. Check whether the instrument is within the calibration period.

b. Ensure that you have warmed up the instrument for at least 40 minutes before

test.
c. Check whether the instrument is under the specified temperature.
d. Check whether the test is under strong-magnetism environment.

e. Check whether the power supplies of the instrument and the test system have a

strong interference.
f. Check whether the performance of the test device used meets the requirement.
g. Make sure that the test device used is within the calibration period.

h. Check whether the test devices used meets the required conditions of the

manual.
i. Check whether all the connections are tight.
j- Check whether the instrument has connected other devices, cables, and
connectors. If yes, check if they are properly connected and work normally.
k. Make sure that the operations conform to settings and processes specified in
the performance verification manual.
l. If the instrument does not work well, press Preset to restore the system to its
preset settings.
m. Check whether the error calculation has faults.
n. Correctly understand the definitions of "Typical”, and "Nominal" values for this
product.
- Typical (typ.): typical performance, which 80 percent of the measurement
results will meet at room temperature (approximately 25°C). The data are not

warranted and do not include the measurement uncertainty.
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- Nominal (nom.): the expected mean or average performance or a designed
attribute (such as the 50Q connector). The data are not warranted and are

measured at room temperature (approximately 25°C).
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25 Appendix

25.1 Appendix A: Options and Accessories

Description Order No.
5 kHz to 8.5 GHz, 2 ports DNA6082-R
5 kHz to 8.5 GHz, 4 ports DNA6084-R
5 kHz to 14 GHz, 2 ports DNA6142-R
5 kHz to 14 GHz, 4 ports DNA6144-R
Model
5 kHz to 20 GHz, 2 ports DNA6202-R
5 kHz to 20 GHz, 4 ports DNA6204-R
5 kHz to 26.5 GHz, 2 ports DNA6262-R
5 kHz to 26.5 GHz, 4 ports DNA6264-R
Standard
Accessory Power Cord -
Measurement | TPA (Time-Domain Analysis) DNA-TDA10
Application
Option DTF (Distance to Fault) DNA-DTF10
El i li ion Kit, 100 kH Hz, 2
ectronic Calibration Kit, 100 kHz to 9 GHz, ECAL109-NE2
ports, Type-N (F), 50 Q
El i li ion Kit, 100 kH 14 GHz, 2
ecttroTnlc Cal\\lleratlsoonQ it, 100 kHz to 14 GHz, ECAL114-NE2
Optional ports, Type-N ().
Accessories . . . .
El [ Kit, 100 kH 26.5 GHz, 3.
ectronic Calibration Kit, 100 kHz to 26.5 GHz, 3.5 ECAL126-35F2
mm (F), 2 ports
4-in-1 LT Mechanical Cali ion Kit, D 26.
in-1 OS echanical Calibration Kit, DC to 26.5 MCAL226-35F5
GHz, 3.5 mm (F)
Mechanical Cali ion Kit, D 4.5 GHz, Type-N
echanical Calibration Kit, DC to 4.5 GHz, Type MCAL104-NM1
. (M), 50 Q
Optional
Accessories 1 1 echanical Calibration Kit, DC to 4.5 GHz, Type-N
(F)ecsoagca alibration Kit, o0 4. z, Type- MCAL104-NE1
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Mechanical Calibration Kit, DC to 9 GHz, Type-N

(M), 50 Q MCAL109-NM1

Mechanical Calibration Kit, DC to 9 GHz, Type-N

(F), 50 Q MCAL109-NF1

Mechanical Calibration Kit, DC to 9 GHz, Type-N

(M &F),500Q MCAL109-NK1

Mechanical Calibration Kit, DC to 4.5 GHz, 3.5 mm

MCAL104-SM1
(M)

Mechanical Calibration Kit, DC to 4.5 GHz, 3.5 mm

MCAL104-SF1
(F)

Mechanical Calibration Kit, DC to 9 GHz, 3.5 mm

MCAL109-SM1
(M)

Mechanical Calibration Kit, DC to 9 GHz, 3.5 mm

MCAL109-SF1
(F)

Mechanical Calibration Kit, DC to 9 GHz, 3.5 mm

MCAL109-SK1
(M&F)

Mechanical Calibration Kit, DC to 26.5 GHz, 3.5 MCAL126-35K1
mm (M & F)

NOTE

For all the mainframes, accessories, and options, please contact the local office of RIGOL.

Appendix B: Warranty

RIGOL TECHNOLOGIES CO., LTD. (hereinafter referred to as RIGOL) warrants that the
product mainframe and product accessories will be free from defects in materials and
workmanship within the warranty period. If a product proves defective within the
warranty period, RIGOL guarantees free replacement or repair for the defective
product.

To get repair service, please contact your nearest RIGOL sales or service office.

There is no other warranty, expressed or implied, except such as is expressly set forth
herein or other applicable warranty card. There is no implied warranty of
merchantability or fitness for a particular purpose. Under no circumstances shall
RIGOL be liable for any consequential, indirect, ensuing, or special damages for any
breach of warranty in any case.
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